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ABSTRAK

PROTOTYPE SISTEM OTOMATISASI MANAJEMEN
OPERASIONAL BERBASIS TRAFFIC DAN KONTROL
PENERANGAN MENGGUNAKAN INTERNET OF THINGS

Oleh:
ZUMROTUL KHILMI
NIT: 56192030048
Program Studi Teknologi Rekayasa Bandar Udara
Program Sarjana Terapan

Teknologi telah menjadi pilar utama dalam perkembangan industri penerbangan
dan operasional bandara. Salah satu aspek penting adalah sistem penerangan di
terminal penumpang. Penelitian ini bertujuan mengembangkan prototype sistem
otomatisasi manajemen operasional berbasis fraffic dan kontrol penerangan
menggunakan Internet of Things (IoT) untuk meningkatkan efisiensi energi dan
memudahkan proses pengisian data manajemen operasional. Metode penelitian
yang digunakan adalah Research and Development (R&D) model Borg dan Gall,
mencakup enam tahap: potensi dan masalah, pengumpulan data, desain produk,
validasi desain, revisi desain, dan uji coba produk. Data dikumpulkan melalui
wawancara dan observasi langsung di Bandar Udara Internasional Juanda. Hasil
menunjukkan bahwa sistem otomatisasi ini mampu meningkatkan efisiensi energi,
mengurangi beban kerja manual, dan menyediakan data real-time yang akurat.
Prototype menggunakan mikrokontroler ESP8266, modul relay 3.3V 2-channel,
sensor arus PZEM-004T, aplikasi Blynk untuk kontrol jarak jauh, dan Google
Spreadsheet untuk monitoring data. Implementasi sistem ini diharapkan dapat
meningkatkan efisiensi operasional dan mendukung pengelolaan energi ramah
lingkungan di bandara.

Kata kunci: 1oT, MOT, kontrol penerangan, efisiensi energi, ESP8266, Blynk,
Google Spreadsheet.
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ABSTRACT

PROTOTYPE OF AN AUTOMATION SYSTEM FOR
OPERATIONAL MANAGEMENT BASED ON TRAFFIC AND
LIGHTING CONTROL USING THE INTERNET OF THINGS

By:
ZUMROTUL KHILMI
NIT: 56192030048
Airport Engineering Technology Studies Program
Applied Bachelor'S Program

Technology has become a key pillar in the development of the aviation industry and
airport operations. One important aspect is the lighting svstem in passenger
terminals. This study aims to develop a prototype of an automated operational
management system based on traffic and lighting control using the Internet of
Things (1oT) to enhance energy efficiency and simplify the operational management
data entry process. The research method used is Research and Development (R&D)
with Borg and Gall's model, encompassing six stages: potential and problems, data
collection, product design, design validation, design revision, and product testing.
Data were collected through interviews and direct observation at Juanda
International Airport. The results indicate that this automation system can improve
energy efficiency, reduce manual workload, and provide accurate real-time data.
The prototype utilizes an ESP8266 microcontroller, 3.3V 2-channel relay module,
PZEM-004T current sensor, Blynk application for remote control, and Google
Spreadsheet for data monitoring. The implementation of this system is expected to
enhance operational efficiency and support environmentally friendly energy
management at airports. Keywords: Internet of Things (IoT), Traffic -based
operational management (MOT), lighting system, energy efficiency, automation,
airport.

Keywords: 10T, MOT, lighting control, energy efficiency, ESP8266, Blynk, Google
Spreadsheet.
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BAB1
PENDAHULUAN

A. Latar Belakang

Teknologi telah menjadi pilar utama dalam perkembangan industri penerbangan dan
operasional bandara. Perkembangan teknologi di sektor ini tidak hanya meningkatkan
efisiensi operasional tetapi juga meningkatkan keselamatan, kenyamanan, dan kecepatan
layanan bagi penumpang. Adopsi teknologi canggih dalam operasional bandara dan
penerbangan mencakup berbagai aspek, mulai dari sistem keamanan, manajemen lalu
lintas udara, hingga pelayanan penumpang. Penggunaan teknologi seperti Internet of
Things (loT), Big Data, dan Machine Learning dalam operasional bandara
memungkinkan pengumpulan dan analisis data dalam jumlah besar. Hal ini
memungkinkan pengelola bandara untuk memprediksi dan mengelola lalu lintas udara

serta penumpang dengan lebih efektif.

Sistem penerangan di terminal penumpang bandara memegang peranan penting dalam
memastikan keamanan, kenyamanan, serta efisiensi operasional bandara. Pencahayaan
bandara sangat penting, terutama di terminal untuk kenyamanan penumpang. Penerangan
yang baik dapat meningkatkan efisiensi operasional di terminal. Penerangan yang cukup
membantu penumpang untuk bergerak dengan mudah, menemukan rute, membaca tanda-
tanda petunjuk, dan mengakses fasilitas bandara dengan lebih mudah. Hal ini dapat
mempercepat pergerakan penumpang dan mengurangi kepadatan di area terminal.
Penggunaan teknologi pencahayaan yang efisien dapat membantu mengurangi konsumsi
energi dan biaya operasional bandara. Sesuai dengan PM No.178 tahun 2015, area
terminal bandara harus memiliki standar pencahayaan antara 200-250 lux, area bagasi
antara 250-300 lux, dan toilet antara 100-150 lux (Pelayanan & Peraturan Menteri
Perhubungan Republik Indonesia Nomor PM 178 Tahun 2015 Tentang Standar

Pelayanan, 2015.

Pandemi COVID-19 yang mulai menyebar secara global sejak awal tahun 2020 telah
memberikan dampak signifikan pada banyak sektor, termasuk industri penerbangan.
Salah satu dampak paling nyata adalah penurunan drastis jumlah penumpang pesawat.
Penurunan ini disebabkan oleh beberapa faktor utama, yakni pembatasan perjalanan yang
diterapkan oleh pemerintah dunia, kekhawatiran masyarakat terhadap risiko penularan
virus, serta penutupan sejumlah tujuan wisata dan bisnis. Menghadapi tantangan pandemi

COVID-19 pada tahun 2020, Angkasa Pura I mencatat penurunan
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jumlah penumpang sebesar 59% dibandingkan dengan tahun 2019. Untuk mengurangi
beban pengeluaran, perusahaan meluncurkan program optimalisasi yang mencakup
peningkatan kinerja petugas serta efisiensi dalam pemeliharaan, utilitas, dan penyewaan
peralatan. Salah satu fokus utama dalam program ini adalah efisiensi penggunaan

peralatan listrik dan elektronik.

Pandemi COVID-19 yang mulai menyebar secara global sejak awal tahun 2020 telah
memberikan dampak signifikan pada banyak sektor, termasuk industri penerbangan.
Salah satu dampak paling nyata adalah penurunan drastis jumlah penumpang pesawat.
Penurunan ini disebabkan oleh beberapa faktor utama, yakni pembatasan perjalanan yang
diterapkan oleh pemerintah dunia, kekhawatiran masyarakat terhadap risiko penularan
virus, serta penutupan sejumlah tujuan wisata dan bisnis. Menghadapi tantangan pandemi
COVID-19 pada tahun 2020, Angkasa Pura | mencatat penurunan jumlah penumpang
sebesar 59% dibandingkan dengan tahun 2019. Untuk mengurangi beban pengeluaran,
perusahaan meluncurkan program optimalisasi yang mencakup peningkatan kinerja
petugas serta efisiensi dalam pemeliharaan, utilitas, dan penyewaan peralatan. Salah satu
fokus utama dalam program ini adalah efisiensi penggunaan peralatan listrik dan

elektronik.

Manajemen Operasional Berbasis Traffic (MOT) bertujuan untuk menekan pengeluaran
salah satunya dari beban pemeliharaan dan beban utilitas di sektor peralatan listrik dalam
bandar udara, tetapi juga memberikan dampak positif dalam upaya konservasi energi
secara lebih luas. Sistem ini membantu memastikan penggunaan energi dilakukan secara
optimal dan efisien melalui pencatatan dan pengawasan yang ketat. Dengan implementasi
MOT yang baik, dapat dipastikan bahwa sumber daya energi yang digunakan akan sesuai
dengan kebutuhan nyata, menghindari pemborosan dan mengurangi jejak karbon dari
kegiatan operasional bandar udara. Hal ini berkaitan dengan peraturan pemerintah nomor
33 tahun 2023 dalam mewujudkan penggunaan energi yang lebih ramah lingkungan dan
berkelanjutan. Manajemen Operasional Berbasis Traffic (MOT) juga dapat membawa
manfaat tambahan dari aspek manajerial dengan menyediakan data yang akurat terkait
penggunaan energi dan waktu operasional perangkat di terminal penumpang. Data ini bisa
menjadi referensi berharga bagi manajemen dalam pengambilan keputusan strategis, baik
dalam perencanaan anggaran maupun dalam perumusan kebijakan operasional yang lebih
efektif. Dengan demikian, program MOT bukan hanya sebuah alat pengendali, tetapi juga
sebagai sumber informasi yang dapat meningkatkan transparansi dan akuntabilitas dalam

pengelolaan energi di lingkungan bandar udara. Implementasi yang baik dari sistem ini




diharapkan akan menciptakan sinergi antara efisiensi energi dan produktivitas operasional

yang akhirnya berdampak positif bagi seluruh pemangku kepentingan.

Prosedur pengisian Manajemen Operasional Berbasis 7raffic (MOT) yang masih
dilakukan secara manual menimbulkan sejumlah kompleksitas. Saat ini, teknisi lapangan
(APS) menerima format MOT melalui grup WhatsApp. Setelah menyelesaikan tugas
yang telah diinstruksikan melalui format tersebut, mereka harus mengirim kembali format
yang telah diisi kepada supervisor. Proses berlanjut dengan Supervisor yang harus
mengetik ulang data ke Google Spreadsheet. Sistem ini tidak hanya membuat alur kerja
menjadi panjang, tetapi juga rawan akan kesalahan input. Kesalahan tersebut bisa jadi
berasal dari kelupaan teknisi lapangan (APS) dalam mengisi format di grup WhatsApp

atau dari proses pengetikan ulang oleh supervisor.

Masalah utama yang sering muncul dari prosedur ini adalah keterlambatan dalam
pelaporan kepada Airport Operation Center Head (AOCH). Keterlambatan ini umumnya
disebabkan oleh beban kerja teknisi lapangan (APS) yang sangat tinggi serta kekurangan
personel. Akibat dari keterlambatan dan ketidakakuratan tersebut, data yang dilaporkan
menjadi kurang reliabel untuk pengambilan keputusan operasional di lapangan. Oleh
karena itu, penerapan sistem yang lebih otomatis dan terintegrasi sangat penting untuk
memastikan efisiensi dan akurasi dalam manajemen operasional berbasis Traffic .
Meskipun demikian, beberapa permasalahan tambahan juga perlu diatasi untuk menjaga
kelancaran operasional. Jarak antara panel penerangan yang berjauhan menyulitkan
kontrol dan pemeliharaan, sementara kekurangan personel dengan hanya tiga orang yang
bertugas menjadi tantangan signifikan. Dalam situasi mendesak, seperti pemadaman
penerangan bersamaan dengan masalah di tenant lain, personel sering kali kewalahan.
Selain itu, kelupaan dalam pengisian MOT juga menambah kompleksitas dalam

manajemen operasional.

Terminal 1 Bandara Juanda adalah salah satu terminal yang menghadapi tantangan
signifikan dalam manajemen operasionalnya. Terminal ini memiliki berbagai jenis lampu
yang mendukung aktivitas operasional sehari-hari. Lampu-lampu ini termasuk TL LED
16W dengan jumlah 1515, TL LED 8W dengan jumlah 673, TL RING 32W dengan
jumlah 96, TL RING 22W dengan jumlah 4, SPOTLIGHT 38W dengan jumlah 56, dan
HIGH MAST 400W dengan jumlah 100.

Khusus untuk lampu BULB LED 10W, diperlukan pengelolaan yang efisien mengingat
jumlahnya yang sangat banyak. Dari 1741 unit BULB LED 10W yang ada, diperlukan




pengelompokan dan strategi pengendalian yang tepat agar penerangan dapat diatur sesuai
kebutuhan tanpa memboroskan energi. Pengelompokan ini akan mempermudah dalam
pengelolaan dan pemantauan, memastikan setiap area mendapatkan penerangan yang

sesuai standar dan efisien.

Untuk mengoptimalkan pengisian Manajemen Operasional Berbasis Traffic (MOT) dan
tugas teknisi lapangan, peneliti membuat perencanaan pembuatan alat yang
memanfaatkan relay 2 channel 10A, modul PZEM (Power/Energy Meter), dan
mikrokontroler ESP8266. Alat ini akan memungkinkan pengendalian lampu secara
otomatis melalui aplikasi Blynk dan pencatatan MOT di Google Sheets, mencakup data
waktu, daya, dan status gerbang (on/off). Sistem ini diharapkan dapat meningkatkan
efisiensi energi dengan mengatur intensitas penerangan secara dinamis dan
memungkinkan pengelolaan yang lebih baik melalui pemantauan dan pengontrolan jarak
jauh.

Pengontrolan lampu melalui aplikasi Blynk akan memberikan fleksibilitas dalam
manajemen penerangan. Aplikasi ini memungkinkan teknisi untuk menghidupkan dan
mematikan lampu sesuai kebutuhan dari jarak jauh, mengurangi ketergantungan pada
kontrol manual yang memakan waktu. Selain itu, pencatatan MOT di Google Sheets akan
mencakup data penting seperti waktu, daya yang digunakan, dan status gerbang (on/off),
memberikan visibilitas yang lebih baik terhadap penggunaan energi dan kondisi
operasional.

Dengan pertimbangan tersebut, proyek ini mengangkat judul “Prototype Sistem
Otomatisasi Manajemen Operasional Berbasis Traffic dan Kontrol Penerangan
Menggunakan Internet Of Things.” Proyek ini tidak hanya akan memberikan manfaat
praktis bagi Terminal 1 Bandara Juanda, tetapi juga berkontribusi signifikan dalam
otomatisasi manajemen operasional dan kontrol penerangan berbasis IoT. Dengan
penerapan sistem yang lebih otomatis dan terintegrasi, diharapkan efisiensi dan akurasi
dalam pengelolaan penerangan dan manajemen operasional di Terminal | Bandara Juanda
dapat tercapai, memberikan pengalaman yang lebih baik bagi penumpang dan operator

bandara.

B. Identifikasi Masalah
Berdasarkan uraian latar belakang yang telah disampaikan, penulis identifikasi masalah
utama sebagai berikut: bagaimana merancang dan membangun sistem otomatisasi yang

mengintegrasikan manajemen operasional berbasis Traffic dan kontrol penerangan




menggunakan Internet of Things (loT) untuk meningkatkan efisiensi energi secara

optimal?

C. Tujuan

Adapun tujuan penelitian yang penulis ingin dapat dari hasil rancangan adalah sebagai
berikut:

1.  Dapat mengetahui cara merancang Prototype pengontrolan penerangan jarak jauh.

2. Dapat mengetahui cara pengisian otomatis Manajemen Operasional Berbasis

Traffic (MOT).

D. Manfaat Penulisan

Adapun manfaat dari penelitian ini adalah sebagai berikut:

1. Prototype ini dapat berfungsi sebagai media pembelajaran untuk para taruna/taruni
jurusan Teknologi Rekayasa Bandar Udara.

2. Meningkatkan efisiensi dan efektivitas pengelolaan penerangan di Terminal Bandara.
Selain itu, penelitian ini juga diharapkan dapat menjadi referensi bagi peneliti lain

yang tertarik dalam mengembangkan sistem penerangan berbasis loT.

E. Batasan Masalah
Berdasarkan pokok masalah maka dengan itu batasan masalah sebagai berikut:
l. Prototype ini hanya menjadi alat simulasi sistem otomatisasi untuk manajemen

operasional berbasis 7raffic dan kontrol penerangan menggunakan Internet of Things

F. Sistematika Penulisan
BAB 1 : PENDAHULUAN
Dalam bab ini berisi tentang latar belakang masalah, rumusan masalah,
pembatasan masalah, tujuan dan manfaat, serta sistematika penulisan.
BABII : LANDASAN TEORI
Dalam bab ini berisi tentang landasan teori yang digunakan penulis

sebagai pembahasan dan kajian penelitian yang relavan.

BABIII : METODE PENELITIAN
Dalam bab ini berisi tentang waktu dan tempat penelitian, desain dan cara

kerja alat, peracangan alat dan teknik.




BAB IV

BAB V

HASIL DAN PEMBAHASAN

Dalam bab ini berisi penjelasan hasil sistem yang digunakan berupa
gambaran umum mengenai rancangan dari penelitian yang akan dibuat.
PENUTUP

Dalam bab ini membahas tentang kesimpulan dan saran selama proses
pengerjaan peralatan yang merupakan inti dari tugas akhir ini untuk ke

depannya agar bisa dibuat lebih baik lagi.




BABII
TINJAUAN PUSTAKA

A. Teori Penunjang

Bandar Udara Internasional Juanda, yang terletak di Surabaya, Jawa Timur, merupakan
salah satu bandara tersibuk di Indonesia dengan kapasitas besar dan fasilitas modern.
Bandara ini melayani penerbangan domestik dan internasional dan terdiri dari dua
terminal utama: Terminal 1 untuk penerbangan domestik dan Terminal 2 untuk
penerbangan internasional serta beberapa penerbangan domestik. Data dari Angkasa
Pura I menunjukkan bahwa jumlah penumpang di Terminal Juanda mencapai 20,5 juta
pada tahun 2018, turun menjadi 8,6 juta pada tahun 2020 akibat pandemi, namun kembali
meningkat menjadi 18,2 juta pada tahun 2023. Seiring dengan bertambahnya jumlah
penumpang, kebutuhan penerangan yang memadai juga meningkat untuk memastikan
kenyamanan dan keamanan penumpang di berbagai area bandara. Penerangan yang
efektif harus memenuhi standar intensitas antara 200 hingga 300 lux dan sesuai dengan
Peraturan Menteri Perhubungan Nomor PM 77 Tahun 2015.

Namun, pengelolaan penerangan di bandara menghadapi beberapa tantangan, termasuk
keterlambatan pelaporan Manajemen Operasional Berbasis Traffic (MOT) kepada
Airport Operation Center Head (AOCH) yang disebabkan oleh beban kerja teknisi
lapangan yang tinggi dan kekurangan personel. Keterlambatan dan ketidakakuratan
laporan membuat data yang diterima kurang reliabel untuk pengambilan keputusan
operasional. Masalah lainnya adalah jarak antara panel penerangan yang menyulitkan
kontrol dan pemeliharaan serta jumlah personel yang terbatas seringkali membuat
mereka kewalahan dalam situasi mendesak. Untuk mengatasi masalah ini, peneliti
merencanakan pembuatan alat berbasis relay 2 channel 10A, modul PZEM, dan
mikrokontroler ESP8266. Alat ini akan mengotomatiskan pengendalian lampu melalui
aplikasi Blynk dan pencatatan data Manajemen Operasional Berbasis Traffic (MOT) di
Google Sheets. Dengan sistem ini, pengaturan intensitas penerangan dapat dilakukan
secara dinamis dan pengelolaan dapat dilakukan lebih efisien melalui pemantauan dan
pengontrolan jarak jauh, meningkatkan efisiensi energi dan mengurangi ketergantungan

pada kontrol manual.

1. Manajemen Operasional Berbasis Traffic (MOT)
Program Manajemen Operasi Berbasis Traffic (MOT) yang diadakan oleh Angkasa Pura

I merupakan sistem digitalisasi penghitungan dan pencatatan penggunaan listrik pada
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terminal Juanda. Dengan adanya MOT, Angkasa Pura I dapat memperkirakan biaya
kebutuhan listrik bandara secara detail, baik harian maupun bulanan. Proses ini sangat
membantu mercka dalam mengelola pengeluaran operasional secara lebih efisien dan
terstruktur. Berdasarkan laman resmi Angkasa Pura Airports, pada triwulan Il tahun
2023, perusahaan mencatat laba bersih sebesar Rp 802 miliar, meningkat 172%
dibandingkan periode yang sama tahun sebelumnya. Implementasi MOT sebagai strategi
efisiensi biaya operasional terbukti berkontribusi signifikan dalam membatasi
pengeluaran dan meningkatkan profit. Berdasarkan surat dari Direktur Utama Angkasa
Pura I bernomor AP.I. 7497/KB.02.01/2022/DU-B, ada tiga prosedur utama dalam
pelaksanaan MOT: perencanaan (pre-operation), pelaksanaan (in-operation), dan

evaluasi (post-operation).

Prosedur perencanaan, atau pre-operation, melibatkan beberapa langkah penting.
Pertama, Airport Services Supervisor (ASS) menerima jadwal penerbangan harian (Daily
Flight Schedule) dari maskapai dan ground handling, kemudian melakukan plotting
penggunaan berbagai fasilitas seperti parking stand dan aviobridge. Selanjutnya,
Passenger Services Supervisor (PSS) merancang penggunaan gate tol, parkir kendaraan,
dan berbagai fasilitas lainnya di area darat dan terminal. Di sisi lain, Airport Security
Services Supervisor (ASSS) mengatur penggunaan mesin X-ray dan penempatan
personel keamanan. Data ini kemudian dikompilasi oleh Supervisor Teknik untuk
menyiapkan fasilitas dan peralatan operasional yang diperlukan, yang kemudian

disampaikan kepada Airport Operations Center Head (AOCH).

Pelaksanaan atau in-operation dilakukan oleh AOCH bersama timnya melalui pertemuan
harian (Daily Meeting) di Airport Operations Control Center (AOCC). Pertemuan ini
membahas kesesuaian plotting penggunaan fasilitas serta jumlah dan penempatan
personel. Jika ditemukan ketidaksesuaian, plotting akan diulang hingga didapat
keselarasan yang pas. Selanjutnya, AOCH mendistribusikan hasil pertemuan kepada unit
kerja terkait untuk dilaksanakan sesuai jadwal. Setiap unit kerja melaksanakan tanggung
jawab operasional masing-masing, dan laporan mengenai operasional ini dijadikan bahan

evaluasi oleh AOCH.

Tahap evaluasi atau post-operation mencakup pelaporan hasil operasional harian dari
setiap unit kerja kepada AOCH. Laporan ini meliputi data realisasi 7raffic penerbangan,

penggunaan fasilitas, serta jumlah personel yang bertugas. Anggaran langsung (direct




cost) terutama untuk kebutuhan listrik tercatat dengan detail, dan ini menjadi dasar

analisis efisiensi.

1. Prototype

Prototipe adalah model awal atau contoh awal dari sebuah produk yang dibuat untuk
menguji konsep atau proses yang diusulkan. Ini adalah langkah penting dalam
pengembangan produk karena memungkinkan pengembang dan pemangku kepentingan
untuk melihat bagaimana produk akan berfungsi dalam praktik sebelum masuk ke tahap
produksi massal. Prototipe dapat berupa fisik atau digital, tergantung pada jenis produk
yang dikembangkan. Misalnya, dalam pengembangan perangkat lunak, prototipe bisa
berupa wireframe atau mockup dari antarmuka pengguna. Sedangkan dalam
pengembangan produk fisik, prototipe bisa berupa model skala kecil atau sampel dari
produk yang sebenarnya.

Praktik di lapangan menunjukkan bahwa penggunaan prototipe sangat membantu dalam
mengidentifikasi masalah dan kekurangan sejak dini dalam proses pengembangan.
Prototipe memungkinkan pengembang untuk melakukan iterasi dan perbaikan secara
cepat berdasarkan umpan balik dari pengguna dan penguji. Selain itu, ini juga membantu
dalam komunikasi antar tim, karena konsep yang kompleks dapat lebih mudah dipahami
melalui representasi visual atau fisik. Dengan demikian, prototipe tidak hanya membantu
dalam pengembangan produk yang lebih baik, tetapi juga menghemat waktu dan biaya

dengan mengurangi risiko kegagalan pada tahap produksi akhir.

2. Penerangan

Penerangan adalah elemen kunci dalam desain ruang publik, tidak hanya berfungsi untuk
menerangi area secara umum tetapi juga untuk meningkatkan keamanan, kenyamanan,
dan efisiensi operasional. Di lingkungan seperti bandara, penerangan harus memenuhi
standar intensitas cahaya yang diperlukan, menghindari silau, dan memastikan distribusi
cahaya yang merata untuk mengoptimalkan visibilitas serta pengalaman pengguna.
Dengan penerangan yang tepat, kegiatan operasional dapat berjalan lancar, dan pengguna

ruang dapat merasa nyaman dan aman.

Di Bandar Udara Internasional Juanda, penerangan di terminal penumpang memainkan
peran krusial dalam menciptakan lingkungan yang aman dan nyaman. Bandara ini
memiliki dua terminal utama Terminal | untuk penerbangan domestik dan Terminal 2
untuk penerbangan internasional serta beberapa penerbangan domestik dengan jumlah

penumpang yang tinggi. Penerangan yang tepat harus diatur untuk mendukung aktivitas
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di berbagai area seperti ruang tunggu, gerbang keberangkatan, dan koridor. Pengaturan
ini sangat penting untuk menjaga kenyamanan penumpang serta efisiensi operasional

bandara.

Standar penerangan di ruang tunggu penumpang Bandar Udara Juanda mengikuti
ketentuan umum yang menetapkan intensitas pencahayaan dalam kisaran 200 hingga 300
lux. Ketentuan ini diatur oleh Peraturan Menteri Perhubungan Nomor PM 77 Tahun
2015, yang menetapkan pedoman teknis terkait penerangan di fasilitas bandara.
Peraturan ini mengharuskan bandara menyediakan pencahayaan yang memadai di semua
area terminal, termasuk ruang tunggu, gerbang keberangkatan, dan koridor, untuk

memastikan keselamatan dan kenyamanan penumpang.

Data inventarisasi pencahayaan di Gedung Terminal 1 Bandar Udara Juanda
mengungkapkan penggunaan beragam jenis lampu dan perlengkapannya yang canggih
dan efisien. Gedung ini dilengkapi dengan berbagai tipe lampu seperti floodlight, TL
LED, bulb LED, TL ring, downlight LED, spotlight, dan high mast. Floodlight
menggunakan lampu merk Philips tipe HPI-T dengan daya 400 watt dan fitting E40,
berjumlah 265 unit, memberikan pencahayaan yang kuat dan merata. TL LED hadir
dalam varian daya 16 watt dan § watt, dengan jumlah unit masing-masing 1515 dan 637,
menawarkan pencahayaan hemat energi. Lampu bulb LED dengan daya 10 watt dan
fitting E27 berjumlah 1741 unit, menunjukkan efisiensi dan popularitasnya di gedung
ini. Downlight LED dari Philips dengan tipe R39, daya 30 watt, dan berjumlah 56 unit,
serta high mast dengan daya 400 watt dan fitting E40 sebanyak 100 unit, memastikan

area yang luas tetap terang dan aman.

3. Kontrol

Sistem kontrol penerangan di Bandara Juanda adalah komponen vital yang memastikan
keselamatan dan efisiensi operasional baik di landasan pacu maupun area terminal.
Teknologi canggih yang digunakan memungkinkan pengaturan intensitas dan pola
pencahayaan secara otomatis berdasarkan kondisi cuaca, waktu, dan aktivitas
penerbangan. Penerangan di landasan pacu memberikan panduan visual bagi pilot,
terutama dalam kondisi visibilitas rendah, sedangkan di area terminal, penerangan
disesuaikan untuk menciptakan suasana yang aman dan ramah, dengan efisiensi energi

diperhatikan melalui penggunaan lampu LED dan sensor otomatis.

Saat ini, sistem kontrol lampu di Bandara Juanda masih manual, di mana teknisi

menghidupkan dan mematikan penerangan melalui panel-panel di ruang tunggu. Proses
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manual ini tidak efisien karena memerlukan tenaga kerja lebih dan meningkatkan risiko
kesalahan manusia, seperti lampu yang tetap menyala saat tidak diperlukan. Efisiensi
energi juga rendah karena kurangnya otomatisasi dan penyesuaian real-time terhadap
kondisi dan kebutuhan penerbangan. Jika sistem ini diintegrasikan dengan teknologi
Blynk berbasis 1oT, kontrol penerangan dapat dilakukan secara otomatis sesuai jadwal
penerbangan, meningkatkan efisiensi energi, mengurangi biaya operasional, serta

meningkatkan kenyamanan dan keamanan bagi penumpang dan staf bandara.

Integrasi sistem kontrol lampu dengan teknologi Blynk berbasis loT dapat meningkatkan
efisiensi energi dan mengurangi biaya operasional bandara. Blynk memungkinkan
kontrol dari jauh, sehingga pencahayaan dapat diatur sesuai jadwal kedatangan dan
keberangkatan pesawat. Lampu hanya akan menyala saat diperlukan, misalnya saat ada
aktivitas penumpang di ruang tunggu, dan mati saat tidak ada aktivitas. Hal ini tidak
hanya menghemat energi listrik tetapi juga meningkatkan kenyamanan dan keamanan
bagi penumpang dan staf bandara. Efisiensi tenaga dan waktu personel adalah kunci

utama dalam meningkatkan produktivitas dan efektivitas operasional bandara.

Untuk mengatasi masalah keterlambatan pelaporan kepada Airport Operation Center
Head (AOCH) dan meningkatkan efisiensi tenaga serta waktu personel, diperlukan alat
yang dapat mempermudah pendataan dan kontrol penerangan di terminal bandara.
Sistem otomatis yang lebih efisien akan mengurangi beban kerja personel,
memungkinkan pelaporan yang lebih tepat waktu dan akurat, serta mendukung
pengambilan keputusan yang lebih baik. Implementasi alat yang efektif diharapkan dapat
meningkatkan kualitas data, operasional, dan pelayanan di terminal bandara,

menciptakan lingkungan kerja yang lebih produktif dan harmonis bagi seluruh personel.
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Berikut laporan harian personil terminal 1 juanda:

Wik e
Gambar II. 1 laporan harian persunﬂh ]! .

Pukul 20:00, teknisi Wawan, Fadli, dan Maftudi melakukan pengecekan lampu
penerangan di Tidem RTT. Pada pukul 22:00, mereka mengganti lampu TL downlight di
LPG 18. Pukul 22:30, teknisi mematikan penerangan di seluruh area, dan pada pukul
22:40, mercka menyalakan penerangan di selasar gate 8, 9, dan 10 berdasarkan
permintaan fasilitas. Pukul 23:00, dilakukan pengecekan panel nomor 26-3 1. Pada pukul
01:30, teknisi melakukan pembersihan ruang panel serta cek terminasi koridor 4.

Kemudian, pada pukul 02:30, mereka menyalakan penerangan di Tl. Akhirnya, pada

pukul 06:00, teknisi melakukan mengefisiensi penerangan sesuai MOT.

4. Monitoring

Monitoring adalah proses pengawasan dan pengumpulan data secara terus-menerus
untuk mengevaluasi kinerja sistem atau perangkat. Dalam konteks teknologi dan industri,
monitoring berfungsi untuk memastikan bahwa sistem atau perangkat beroperasi sesuai
dengan standar dan ekspektasi yang telah ditetapkan. Monitoring juga bertujuan untuk
mendeteksi dan mengidentifikasi masalah atau anomali yang mungkin terjadi sehingga
dapat segera diambil tindakan korektif. Salah satu aplikasi monitoring yang penting
adalah monitoring daya untuk lampu di terminal penumpang bandara, di mana proses
pemantauan konsumsi listrik dari lampu-lampu yang ada di area terminal sangat penting
untuk memastikan bahwa penggunaan energi berada pada tingkat yang efisien dan untuk
mendeteksi adanya kegagalan atau penyimpangan pada sistem penerangan yang dapat

mengganggu kenyamanan dan keselamatan penumpang.
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Perencanaan monitoring untuk lampu di terminal penumpang bandara melibatkan
pengumpulan data yang terperinci, seperti waktu dan tanggal, konsumsi daya, serta status
on/off untuk lampu di Gate 10 dan Gate 11. Data ini membantu dalam analisis
penggunaan energi dan pengelolaan operasional lampu secara lebih efisien. Dalam
praktiknya, monitoring ini dapat dilakukan menggunakan Google Sheet yang
memanfaatkan spreadsheet online sebagai platform untuk mengumpulkan, menyimpan,
dan menganalisis data secara real-time. Proses monitoring dimulai ketika user mengklik
tombol on/off pada aplikasi Blynk. Sinyal perintah ini dikirim ke modul ESP8266 yang
kemudian mengaktifkan relay, yang mengalirkan arus listrik ke lampu atau beban
lainnya. Arus yang mengalir melewati Current Transformer (CT) pada modul PZEM
untuk mengukur daya listrik yang digunakan, kemudian data daya dikirim kembali ke
ESP8266 untuk diolah dan hasilnya dikirim ke Google Sheet untuk dicatat dan dianalisis
lebih lanjut. Dengan sistem ini, monitoring daya dapat dilakukan secara otomatis dan
data tersimpan secara real-time di Google Sheet, sehingga memudahkan dalam

pemantauan dan pengambilan keputusan.

5. Internet of Things (1oT)

Internet of Things (10T) adalah jaringan perangkat fisik yang terhubung melalui internet,
memungkinkan mereka untuk mengumpulkan dan berbagi data satu sama lain. IoT
mencakup berbagai perangkat seperti sensor, kamera, peralatan rumah tangga dan
industri yang dapat berkomunikasi dan berinteraksi secara otomatis tanpa memerlukan
intervensi manusia. Teknologi ini memungkinkan efisiensi operasional yang lebih tinggi,
peningkatan kualitas hidup, dan penerapan dalam berbagai bidang seperti kesehatan,
transportasi, dan industri. Menurut penelitian, adopsi loT diharapkan akan terus

meningkat seiring dengan perkembangan teknologi jaringan dan komputasi awan

a. NodeMcu ESP8266

NodeMcu ESP8266 adalah sebuah mikrokontroler berbasis Wi-Fi yang murah dan
serbaguna, sering digunakan untuk proyek-proyek Internet of Things (10T). Perangkat ini
memanfaatkan chip ESP8266 yang revolusioner, diproduksi oleh Espressif Systems,
untuk memberikan kemampuan Wi-Fi pada mikrokontroler , memungkinkan pengguna
menghubungkan perangkat mereka ke internet dengan mudah. NodeMcu dilengkapi
dengan firmware berbasis Lua, meskipun banyak pengguna lebih memilih menggunakan
Arduino IDE untuk pemrograman karena familiaritas dan dukungan luas yang

ditawarkan. Keunggulan utama NodeMcu ESP8266 terletak pada kemampuan
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melakukan berbagai operasi jaringan seperti mengirim data ke server web, menerima

data dari sensor, dan berinteraksi dengan aplikasi mobile melalui koneksi Wi-Fi.

Chip ESP8266 dalam NodeMcu mendukung berbagai mode operasi Wi-Fi termasuk Wi-
Fi Direct (P2P), soft-AP, dan mode STA/AP/STA+AP, memberikan fleksibilitas tinggi
dalam pengembangan aplikasi. Beroperasi pada tegangan 3.0V hingga 3.6V dengan
rentang suhu operasi -40°C hingga 125°C, ESP8266 memastikan kinerja stabil di
berbagai kondisi lingkungan. Konsumsi daya yang efisien, dengan konsumsi deep sleep
kurang dari 10pA dan konsumsi transmisi maksimum 180mA, menjadikan ESP8266
pilihan ideal untuk aplikasi yang memerlukan konektivitas aman dan andal. Dukungan
protokol enkripsi seperti WEP dan WPA/WPA2 menambah keamanan koneksi,

menjadikannya sangat cocok untuk sistem IoT dan smart home.

NodeMcu ESP8266 juga menawarkan sejumlah pin GP1O yang dapat digunakan untuk
mengontrol sensor, relay, dan berbagai perangkat lainnya, menjadikannya pilihan
populer di kalangan pembuat dan pengembang teknologi. Modul ini sering muncul dalam
jurnal akademis terkait [oT dan sistem smart home, menunjukkan dampaknya sebagai
solusi hemat biaya dalam mengembangkan infrastruktur teknologi pintar. Meskipun
terdapat beberapa kelemahan seperti keterbatasan memori dan kebutuhan pasokan daya
yang stabil, fleksibilitas dan aksesibilitas yang ditawarkan oleh NodeMcu ESP8266
membuatnya menonjol di antara mikrokontroler lainnya. Pengembangan perangkat
lunak difasilitasi dengan dukungan alat pengembangan seperti Arduino IDE, PlatformlO,
dan ESP-IDF, serta alat flashing seperti esptool.py, memungkinkan pengembang

membuat solusi IoT yang inovatif dan efisien.
Berikut datasheet ESP8266:

1. Fitur
a.  Wi-Fi Direct (P2P), sofi-AP
b.  Stack protokol TCP/IP terintegrasi

c. TR switch terintegrasi, balun, LNA, power amplifier, dan jaringan
pencocokan
d.  PLL terintegrasi, regulator, dan unit manajemen daya

e.  Mendukung APSD untuk aplikasi VoIP
f. Mendukung antarmuka ko-eksistensi Bluetooth

g.  RF yang mengkalibrasi sendiri, tidak memerlukan bagian RF eksternal
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h.  Dapat diskalakan ke 802.11b/g/n
i. GPIO, UART, SPL 12C, 128, ADC, dan PWM
] Mode operasi STA/AP/STA+AP
k.  Konsumsi daya deep sleep <10uA, kebocoran daya saat mati < 5uA
L Bangun dan kirim paket dalam < 2ms
m. Konsumsi daya standby < 1.0mW (DTIM3)
Spesifikasi
n.  Tegangan Operasi: 3.0V ~ 3.6V
o.  Rentang Suhu Operasi: -40°C ~ 125°C
p.  Standar Wi-Fi: 802.11 b/g/n
q- Rentang Frekuensi: 2.4GHz ~ 2.5GHz (2400M ~ 2483.5M)
. Daya Keluaran: +19.5dBm (802.11b)
s.  Sensitivitas: -98 dBm
t. Enkripsi: WEP, WPA/WPA2
u.  Memori Flash: 512 KB (ESP-01) hingga 4 MB (ESP-12E)
v.  Konsumsi Arus:
e Transmisi: 180mA (Max)
e Standby: <1.0mW
Tabel 11. 1 Datasheet ESP8266
Spesifikasi NODEMCU ESP8266
Tegangan Input 3,3-5V
GPIO 13 Pin
Kanal PWM 10 Kanal
10 Bit ADC Pin 1 Pin
Flash Memory 4MB
Frekuensi 2,4 GHz -22,5 GHz

USB to Serial Converter CH430G
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Gambar II. 2 NodeMcu ESP8266
sumber: miro.medium.com (2024)

Relay 3.3V 2-channel adalah modul yang dirancang untuk mengendalikan beban listrik
berdaya tinggi menggunakan sinyal tegangan rendah dari mikrokoniroler atan sumber
kontrol lainnya. Modul ini sangat berguna dalam aplikasi otomasi rumah, kontrol
industri, dan proyek DIY yang lebih kompleks. Dengan dua channel yang tersedia, modul
ini memungkinkan kontrol dua perangkat secara independen, dengan setiap channel
mampu menangani tegangan kontak hingga 250VAC atau 30VDC dan arus hingga 10A,
menjadikannya ideal untuk mengendalikan perangkat seperti lampu, motor, dan pemanas

dengan aman dan efektif.

Modul ini bekerja dengan menerima sinyal tegangan rendah (3.3V) melalui pin input
(IN1 dan IN2) dari mikrokontroler , yang biasanya berasal dari pin output digital
mikrokontroler . Sinyal ini mengaktifkan transistor pada modul relay yang berfungsi
sebagai saklar elektronik untuk menggerakkan koil relay. Arus yang mengalir melalui
koil relay menciptakan medan magnet yang menarik tuas kontak relay, mengubah posisi
kontak dari terbuka (NO) ke tertutup (NC) atau sebaliknya, tergantung pada konfigurasi

relay.

Relay 2 channel 3.3V ini juga menggunakan optokopler untuk isolasi listrik antara sirkuit
kontrol tegangan rendah dan sirkuit daya tinggi yang dikendalikan oleh relay, melindungi
mikrokontroler dari lonjakan tegangan dan gangguan elektromagnetik. Dengan kontak
relay yang terisolasi, relay ini dapat mengalihkan arus AC hingga 250VAC atau arus DC
hingga 30VDC dengan arus maksimum hingga 10A. Hal ini memungkinkan modul relay
digunakan dalam berbagai aplikasi seperti menyalakan lampu, kipas, dan pompa, serta

memberikan kontrol jarak jauh yang aman dan efisien untuk berbagai perangkat listrik.




Parameter Utama

Tegangan Operasi (VCC)

Arus Operasi

Tegangan Trigger (IN1 dan
IN2)

Kapasitas Kontak

Waktu Operasi

Isolasi

Indikator LED

Suhu Operasional

Tegangan Operasi

Jumlah Channel

Tegangan Kontak Maksimal
Arus Kontak Maksimal
Arus Trigger

Waktu Operasi

Waktu Lepas
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Gamb;; ll .3 E;lay 3.3V 2-channel
sumber: http://indomaker.com/wp-content/uploads/2019/08/2-channel-relay.jpg dan
penulis (2024)

Tabel II. 2 spesifikasi Relay 3.3V 2-channel

Spesifikasi
Nominal: 3.3V DC

Arus Aktif: 70-100mA per channel (saat relay
diaktifkan)

Level Tegangan: 3.3V DC (aktif rendah)

Tegangan Maksimum AC: 250V

Arus Maksimum AC: 10A

Tegangan Maksimum DC: 30V

Arus Maksimum DC: 10A

Waktu Tarik (Operate Time): < 10 ms

Waktu Lepas (Release Time): < 5 ms
Opto-isolator: Memisahkan sirkuit kontrol dan
beban, menyediakan isolasi galvanik

Setiap relay memiliki LED indikator yang
menunjukkan status operasi (LED menyala saat
relay diaktifkan)

Rentang Suhu: -40°C hingga +85°C
3.3V

2

250VAC or 30VDC

10A

5mA

10ms

Sms
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b. Modul PZEM-004T

PZEM-004T adalah modul elektronik canggih yang dirancang untuk mengukur berbagai
parameter listrik seperti tegangan, arus, daya, frekuensi, energi, dan faktor daya. Dengan
fungsi yang lengkap, modul PZEM-004T sangat ideal untuk digunakan dalam proyek
atau eksperimen pengukuran daya pada jaringan listrik, baik di rumah maupun di
gedung(Taufiqurohman et al., 2023).

Modul PZEM-004T dapat terhubung dengan NodeMCU atau platform sumber terbuka
lainnya, memungkinkan pengukuran tegangan, arus, dan daya aktif. Dimensi fisiknya
adalah 3,1 x 7.4 cm. PZEM-004T dilengkapi dengan kumparan trafo arus berdiameter
3mm yang mampu mengukur arus hingga 100A (Watkins, 2020). Untuk beroperasi,
modul ini perlu dihubungkan dengan sumber tegangan AC sehingga dapat mengukur dan
menampilkan nilai daya dan energi listrik. Dalam pengujian sensor PZEM, dilakukan
pengukuran untuk memperoleh nilai pembacaan sensor dan nilai pengukuran manual
dengan alat ukur. Hal ini bertujuan untuk menentukan nilai persentase kesalahan
(%error). Tingkat kesalahan yang baik adalah di bawah 10%. Nilai %error ini dihitung

menggunakan persamaan berikut (Prasetyo et al., 2022):

nilai pembacaan sensor — nilai pembacaan alat ukur
x 100%

Y%eror = —
nilai pembacaan alat ukur

Menurut datasheet, modul PZEM-004T beroperasi pada tegangan 80-260VAC, memiliki
tegangan uji 80-260VAC, daya maksimal 100A/22.000W, dan frekuensi operasi
45~65Hz. Berikut karakteristik dan spesifikasi PZEM-004T:

Tabel 11. 3 karakteristik dan spesifikasi PZEM-004T

Karakteristik spesifikasi

Tombol daya bersih/reset energi Tegangan kerja 80 ~ 260 VAC
Fungsi penyimpanan data saat mati
listrik (penyimpanan kumulatif
sebelum mati listrik)

Daya terukur 100 A / 22000 W

Pengukuran daya 0 ~ 9999 kKW Working Frequency 45 — 65 Hz

Pengukuran tegangan 80 ~ 260 Measurement accuracy 1.0
VAC

Pengukuran arus 0 ~ 100 A
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Deskripsi fungsi sensor PZEM-004T:

I. Tegangan
a. Rentang pengukuran 80 ~ 260 V
b. Ketepatan ukur 0.5%, Resolusi 0.1 V
2. Arus

a. Mulai mengukur arus 0.01 A untuk sensor PZEM-004 T-10A dan 0.02 untuk
sensor PZEM-004 T-100A

b. Rentang pengukuran 0 ~ 10 A untuk sensor PZEM-004 T-10A dan 0 ~ 100 A
untuk sensor PZEM-004 T-100A

c. Ketepatan ukur 0.5%

d. Resolusi 0.001 A

3. Daya

a. Mulai mengukur daya 0.4 W

b. Rentang pengukuran 0 ~ 2.3 kW untuk sensor PZEM-004 T-10A dan 0 ~ 23 kW
untuk sensor PZEM-004 T-100A

c. Ketepatan ukur 0.5%

d. Resolusi 0.1 W

e. Format tampilan: <1000 W, menampilkan satu desimal, seperti: 999.9 W; =1000
W, menampilkan hanya bilangan bulat, seperti: 1000 W

4. Faktor daya

a. Rentang pengukuran 0.00 ~ 1.00

b. Ketepatan ukur 1%

c. Resolusi 0.01

5. Frekuensi

c. Rentang pengukuran 45 Hz ~ 65 Hz

d. Ketepatan ukur 0.5%

e. Resolusi 0.1 Hz

6. Energi

a. Rentang pengukuran 0 ~ 9999.99 kWh

b. Ketepatan ukur 0.5%

c. Resolusi 1 Wh

d. Format tampilan: <10 kWh, unit tampilan adalah Wh (1 kWh = 1000 Wh),
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Gambar II. 4 Modul PZEM-004T

f. LED 10 watt

Dari data inventaris Daftar Fasilitas Peralatan Elektrikal Bandar Udara Internasional
Juanda Surabaya, penggunaan bulb LED 10 watt tersebar hampir di seluruh area
Terminal 1, dengan total 1,741 buah. Sebanyak 733 bulb LED tersebar di 15 ruang
tunggu, memberikan pencahayaan efisien dan nyaman bagi penumpang. Lampu ini
mempunyai masa pakai hingga 15,000 jam, dan waktu penyalaan kurang dari 0.5 detik,
serta sudut pancaran 200 derajat untuk distribusi cahaya merata. Adopsi teknologi LED
ini tidak hanya meningkatkan kenyamanan dan keamanan penumpang tetapi juga
mendukung keberlanjutan dengan mengurangi konsumsi energi dan emisi karbon,

sejalan dengan upaya global menjaga lingkungan.

PHILIPS

lhq
ik

Gambar II. 5 LED 10 watt
Sumber: https://p-id.ipricegroup.com (2024)




Dengan spesifikasi umum

Spesifikasi
Model
Daya
Fitting
Voltase
Frekuensi
Kecerahan
Suhu warna
Sudut pancaran cahaya
Masa pakai
Waktu penyalaan

g. Kabel

Tabel 11. 4 LED 10 watt
Detail

Philips LED Bulb 10W
10 watt

E27

220-240 VAC

50-60 Hz

806 lumens

6500K (Putih Dingin)
200 derajat

15.000 jam

<0,5 detik
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Pada penelitian ini, peneliti menggunakan kabel model Extrana 1x1,5 mm? PVC yang

dikenal dengan kualitas dan keandalannya. Kabel ini sangat cocok untuk berbagai

aplikasi, termasuk instalasi listrik dalam ruangan, distribusi daya listrik, pencahayaan,

dan kontrol. Isolasi PVC yang tahan lama melindungi konduktor dari kerusakan fisik dan

lingkungan, serta keamanan penggunaan. Selain itu, konduktor tembaga berkualitas

tinggi yang digunakan dalam kabel ini menyediakan konduktivitas listrik yang optimal,

sehingga menjamin kinerja yang efisien dan andal dalam berbagai kondisi operasional.

Penggunaan kabel Extrana 1x1,5 mm? PVC dalam penelitian ini menegaskan komitmen

terhadap standar kualitas tinggi dan keandalan dalam setiap aspek instalasi listrik.

Berikut data umum kabel Extrana 1x1,5 mm? PVC:

Item
Model
Jenis kabel
Material konduktor
Tegangan pengoprasian
Resistansi konduktor
Arus penghantar maksimal

Suhu operasional

Tabel II. 5 spesifikasi kabel
Detail

Extrana 1x1,5 mm?* PVC

Kabel tembaga tunggal dengan isolasi PVC
Tembaga

450/750V

12.1 /km (maks)

I5A

-15°C hingga +70°C
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Gambar 11. 6 Kabel
Sumber: images.tokopedia.net/img/cache/500-square (2024)

B. Kajian Terdahulu

Sebagai dasar yang mendukung penyusunan proyek akhir ini, penulis menyajikan

penelitian terdahulu yang dapat dijadikan sebagai rujukan penulis. Penelitian terdahulu

yang menjadi rujukan adalah penelitian yang relevan dengan proyek akhir yang sedang

disusun oleh penulis. Berikut penelitian terdahulu yang diambil oleh penulis sebagai

rujukan:

I.

Jurnal penelitian pertama yang ditulis oleh Alfian, Raviki Dwi Haryudo,
Subuh Isnur Kartini, Unit Three Kholis, Nur berjudul “Rancang Bangun Alat
Monitoring Pemakaian Tarif Listrik Dan Kontrol Daya Listrik Pada Rumah
Kos Berbasis Internet of Things.” Penelitian ini menggunakan berbagai
komponen seperti Mikrokontroller NodeMCU ESP8266, modul PZEM-004T,
modul relay 5V, LCD I2C 20x4, dan RTC DS3231. Alat ini dirancang untuk
membantu pemilik dan penyewa kos dalam memantau penggunaan tarif listrik
secara real-time dan jarak jauh. alat monitoring ini mampu berfungsi dengan
baik dengan nilai error rata-rata pembacaan tegangan sebesar 1,4% dan arus
sebesar 3,7%, yang menunjukkan tingkat akurasi yang tinggi. Penelitian ini
menggabungkan teknologi loT dengan aplikasi Blynk untuk monitoring dan
Google Firebase untuk penyimpanan data, sehingga memudahkan pemantauan
penggunaan energi listrik melalui smartphone. (Alfian et al., 2021)

Jurnal penelitian kedua yang ditulis oleh Heri Purnadi dengan judul
“Pemanfaatan Google Spreadsheet Dan Google Data Studio Sebagai
Dashboard Suhu Dan Kelembaban Di Laboratorium.” Tujuan penelitian ini

yaitu Google Spreadsheet dan Google Data Studio sangat bermanfaat sebagai
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dashboard untuk memonitor suhu dan kelembaban di laboratorium. Dashboard
ini memberikan informasi secara lebih mudah dan real-time. Selain itu,
dashboard juga membantu petugas dalam merencanakan jadwal perbaikan AC
dan dehumidifier berdasarkan informasi grafik, sehingga dapat mengantisipasi
kerusakan peralatan tersebut. Input data melalui Google Spreadsheet
memungkinkan data tersedia dengan cepat untuk audit eksternal. Pengolahan
dan visualisasi data menggunakan Google Data Studio menawarkan solusi
alternatif bagi institusi. Dengan dukungan berbagai sumber data, Google Data
Studio memudahkan integrasi laporan dari sumber yang berbeda. Selain itu,
fitur berbagi laporan dengan pengguna lain tetap menjaga keamanan informasi
yang ditampilkan.(Heri Purnadi, 2021)

. Jurnal penelitian ketiga yang ditulis oleh Andi Syofian, Haryanto dengan judul
“Alat Monitoring Kelistrikan Rumah Tangga Berbasis Blynk™ Penelitian ini
merancang alat monitoring kelistrikan rumah tangga berbasis Blynk, yang
menggunakan mikrokontroler  Wemos D1 dan sensor PZEM-004T untuk
mengukur dan menampilkan nilai arus, tegangan, daya listrik, dan energi yang
digunakan. Sistem ini memungkinkan pemantauan biaya tagihan listrik dari
jarak jauh melalui aplikasi Blynk yang terhubung ke internet. Pada pengujian,
alat ini menunjukkan keakuratan pembacaan yang tinggi dengan error hanya
0,02% saat mengukur nilai tegangan jala-jala PLN. Semua fungsi alat bekerja
dengan baik, termasuk pengukuran dan pengiriman data secara nirkabel yang
dapat diakses secara real-time melalui smartphone

. Jurmal penelitian keempat yang ditulis oleh Rayi Ayu Safitri dengan judul
“Rancang Bangun Sistem Kendali Lampu Pada Gedung Menggunakan
Wireless Fidelity (Wi-Fi) Berbasis NodeMCU ESP8266.” Penelitian ini
bertujuan untuk memudahkan pengontrolan lampu menggunakan smartphone
yang terhubung dengan Wi-Fi, serta meminimalisir risiko konsleting dengan
pemantauan tegangan dan arus listrik secara real-time. Sistem ini dapat bekerja
dengan baik dalam radius kurang dari 30 meter dengan menggunakan hotspot
smartphone sebagai koneksi internet(Safitri & Lampu, 2018)

. Jurnal penelitian kelima yang ditulis oleh Mohamad Nawal Taufiqurohman,
Muhammad Ardi Alfianto, Indrawan Sugistoro, Helmi Yazid, Roy
Hamonangan Pardosi, Wahyu Setyo Pambudi dengan judul “Sistem

Monitoring Energi Listrik Rumah Tangga Menggunakan Sensor PZEM004T
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dengan Integrasi Firebase dan Blynk” Penelitian ini bertujuan untuk
pemantauan dan kontrol konsumsi energi listrik rumah tangga secara real-
time, membantu pengguna dalam mengambil keputusan cerdas untuk
mengoptimalkan penggunaan energi dan mengurangi biaya. Rentang tegangan
bervariasi antara 186,8 hingga 198 volt, daya menunjukkan fluktuasi antara
32,3 hingga 233,5 watt, dan faktor daya berkisar antara 0,61 hingga 0,82
(Taufiqurohman et al., 2023)

). Jurnal penelitian keenam yang ditulis oleh Ridyandhika Riza Ibrahim, Bekti

Yulianti, ST. MT dengan judul “Rancang Bangun Monitoring Pemakaian Arus
Listrik PLN Berbasis IoT” Penelitian ini bertujuan untuk menguji Alat
monitoring yang dikembangkan menunjukkan nilai rata-rata error yang sangat
kecil, yaitu 0.0038% untuk tegangan, 0.1116% untuk arus, dan 0.00294%
untuk daya. Sistem ini memudahkan pemilik dan penyewa rumah indekos
untuk memantau penggunaan energi listrik setiap kamar, serta memberikan
data biaya pemakaian yang akurat berdasarkan tarif listrik yang ditetapkan

pemerintah(Ridyandhika Riza Ibrahim, Bekti Yulianti, 2023)




BAB I11
METODE PENELITIAN

A. Desain Penelitian

Tujuan penelitian ini adalah mengembangkan Profotype untuk Otomatisasi Manajemen
Operasional Berbasis Traffic dan Kontrol Penerangan Menggunakan Internet of Things
(IoT). Penelitian ini menggunakan pendekatan Research and Development (R&D) model
Borg dan Gall (1989), yang terdiri dari sepuluh langkah. Namun, dalam penelitian ini,
penulis hanya menerapkan enam langkah pertama. Penulis merujuk pada buku modifikasi
Sugiyono (2014), yang merekomendasikan agar penelitian tesis atau disertasi dibatasi
hingga tahap uji coba produk, mengingat melanjutkannya hingga tahap kesepuluh akan

memerlukan investasi biaya dan waktu yang signifikan.

Proses pengembangan prototipe untuk Prototype Sistem Otomatisasi Manajemen
Operasional Berbasis Traffic dan Kontrol Penerangan Menggunakan Internet of Things
ini menggunakan model penelitian Borg dan Gall dalam skala kecil, yang mencakup enam

tahap penelitian pengembangan. Tahapan-tahapan tersebut meliputi

1. Potensi dan Masalah;
2. Pengumpulan Data;
3. Desain produk;

4, Validasi desain;

5 Revisi desain;

6.  Uji coba produk;

Pendekatan ini memastikan bahwa pengembangan dilakukan secara sistematis dan
efektif, memungkinkan produk yang dihasilkan siap untuk diuji dan disempurnakan lebih

lanjut.

Potensi dan Validasi Desain 5 Revisi Desain
Masalah
Pengumpulan N Desain Produk Upt Coba
Data Produk

Gambar 1II. 1 Flowchart Desain Penelitian
sumber: penulis (2024)
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B. Prosedur Penelitian
Pada tahap ini digunakan proses penelitian sesuai dengan Langkah-langkah pada
penggunaan metode Research and Development (R & D) dan peneliti meringkas metode

penelitian dan pengembangan ini sebagai berikut:

a.  Potensi dan Masalah

Penelitian ini berfokus pada potensi masalah terkait pengontrolan lampu dan pemantauan
penggunaan daya lampu pada MOT yang kurang efektif di Bandar Udara Internasional
Juanda. Tujuan utama penelitian ini adalah untuk mengembangkan prototipe
pengontrolan lampu melalui platform Blynk dan memonitor penggunaan daya lampu
menggunakan Google Sheets. Selain itu, penelitian ini bertujuan mengusulkan solusi atau
perbaikan yang dapat menggantikan sistem manual menjadi sistem yang lebih otomatis
dan mudah digunakan.

b.  Pengumpulan Data

Langkah selanjutnya untuk mengatasi permasalahan tersebut adalah mengumpulkan data
dan informasi langsung dari lapangan, khususnya dari unit Listrik di Bandara Udara
Juanda. Observasi menunjukkan bahwa pengontrolan lampu dan pengisian MOT di unit
Listrik masih dilakukan secara manual dan kurang efektif. Oleh karena itu, penelitian ini
bertujuan untuk menghasilkan produk baru yang dapat menunjang dan mempermudah
kinerja personel unit Listrik dalam melaksanakan tugas pengontrolan dan monitoring
MOT.

c.  Desain Produk

Berdasarkan masalah-masalah di lapangan dan informasi yang telah dikumpulkan,
peneliti merancang desain alat yang sesuai dengan kebutuhan untuk menyelesaikan
masalah tersebut. Produk penelitian ini akan menghasilkan sebuah alat kontrol dan
monitoring MOT yang mampu mendukung kinerja harian personel lapangan secara
efektif.

d.  Validasi Desain

Hasil penelitian akan dinilai oleh para ahli atau pakar berpengalaman yang akan
mengevaluasi produk baru yang telah dirancang, dengan tujuan untuk mengidentifikasi
kekurangan dan kelibihan pada prototype.

¢.  Revisi Desain

Setelah desain protofype divalidasi oleh para ahli, kekurangan prototype dapat
teridentifikasi. Kemudian kekurangan tersebut akan direvisi untuk meningkatkan kualitas

prototype menjadi lebih baik.
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f. Uji Coba Produk

Tahap ini dilakukan setelah prototype mendapatkan penilaian oleh para ahli materi bahwa

produk yang dibuat layak untuk diuji coba dilapangan. Uji coba prototype dilakukan

bertujuan untuk mengetahui cara kerja dan fungsi prototype nantinya juka diterapkan

dilapangan.

C. Perancangan Alat

Berdasarkan alur desain penelitian yang dibuat oleh penulis, maka akan dijabarkan proses

perancangan alat, yaitu:

L.

Identifikasi masalah yaitu mencari kendala atau hambatan bagi taruna dalam
melaksanakan praktikum.

Desain alat adalah proses membuat rancangan alat sebelum pembuatan alat.
Pembuatan alat dibuat oleh penulis untuk mengetahui tahapan- tahapan dalam
proses pembuatan alat.

Setelah pembuatan alat, maka penulis akan melakukan pengujian alat untuk
mengetahui kinerja alat sesuai dengan yang diharapkan.

Jika dalam proses pengujian alat terdapat kendala seperti kemacetan saat
pengoperasian atau ukuran tidak sesuai, maka akan dilakukan optimalisasi agar
alat dapat bekerja dengan baik.

Hasil pengujian dilakukan untuk mendapatkan data pengujian alat.

Kesimpulan akan dibuat setelah seluruh tahapan perencanaan alat dapat

terselesaikan dengan baik.

Pada bab ini penulis akan menjelaskan bagaimana proses perancangan alat mulai dari

desain serta konsep otomatisasi manajemen operasional berbasis Traffic dan kontrol

penerangan menggunakan fnternet of Things.
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Gambar III. 2 Flowchart Perangkaian Alat
sumber: penulis (2024)

D. Desain Alat

Saat ini, proses pengisian MOT dan kontrol penerangan masih manual. Supervisor
mengirim format MOT lewat grup WhatsApp, lalu petugas lapangan mengisi format
tersebut di lapangan dan mengirimnya kembali ke supervisor. Supervisor kemudian
mengisi MOT ke format yang ditetapkan oleh Bandar Udara Juanda. Teknisi lapangan
akan menghidupkan dan mematikan lampu langsung di panel-panel ruang tunggu.
Berikut blok diagram sistem otomatisasi untuk manajemen operasional berbasis Traffic

dan kontrol penerangan pada desain prototype yang dibuat oleh penulis:

@

N\
0 synk

Googfe Srmets

Gambar I11. 3 Desain Alat
sumber: penulis (2024)
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1. Carakerja alat

a. Pengguna mengontrol lampu (relay) melalui aplikasi Blynk pada smartphone
mereka. Aplikasi Blynk telah dikonfigurasi dengan tombol atau sakelar untuk
mengontrol perangkat fisik (relay) yang terhubung ke ESP8266.

b. Aplikasi Blynk mengirimkan perintah on/off melalui koneksi internet (WiFi atau
data seluler) ke server Blynk.

c. ESP8266, yang terhubung ke jaringan WiFi dan terhubung ke Blynk
menggunakan token autentikasi, menerima perintah dari server Blynk untuk
mengubah status relay. Misalnya, menghidupkan atau mematikan lampu.

d. Ketika relay diaktifkan (lampu dinyalakan), ESP8266 juga membaca data arus
dari sensor PZEM yang terhubung ke salah satu pin GP1O-nya. Sensor PZEM
ini digunakan untuk mengukur konsumsi listrik saat lampu dalam keadaan aktif.

e. Data arus yang terbaca dari sensor PZEM dikirimkan oleh ESP8266 ke Google
Sheet. ESP8266 dapat menggunakan Google Sheets APl atau layanan pihak
ketiga seperti IFTTT untuk mengirim data ini ke spreadsheet yang ditentukan
dalam akun Google.

2. Komponen perangkat keras

a. ESP8266

b. PZEM-004T

c. Relay 3.3v 2 channel

d. Lampu led 10 watt

e. Fitting lampu

3. Komponen perangkat lunak

a. Arduino IDE

b. Blynk

c. Google SpreadSheet

E. Teknik Pengujian
Pengujian sangat penting dalam proyek akhir atau penelitian untuk memastikan
komponen alat mencapai hasil yang diharapkan. Tahapan analisis teknik pengujian
meliputi:
1. Pengujian: Dilakukan setelah sistem menjadi satu kesatuan utuh. Peneliti menguji
untuk mengetahui margin error sebelum digunakan.
2. Evaluasi: Peneliti mengevaluasi apakah hasil pengujian sesuai dengan harapan.

Jika sesuai, alat akan diimplementasikan.
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F. Teknik Analisis

Metode pengumpulan data yang digunakan dalam penulisan tugas akhir antara lain:

1.

Metode study literatur, yaitu cara menelaah, menggali, serta mengkaji teori -
teori yang mendukung dalam pemecahan masalah yang diteliti.

Discuss, yaitu melakukan konsultasi dan bimbingan dengan dosen dan pihak -
pihak lain yang dapat membantu terlaksananya perancangan ini.

Metode analisis rancangan, yaitu dengan mengadakan analisa rancangan
konstruksi terhadap aplikasi beserta fitur-fitur yang disediakan.

Metode experiment, yaitu dengan cara melakukan uji coba untuk mendapatkan

data - data hasil percobaan.

G. Tempat dan Waktu Penelitian

L.

Tempat Penelitian

Penelitian ini dilakukan di unit equipment bandar udara internasional Juanda.
Berdasarkan pengamatan di lapangan dalam kegiatan apel dan waktu menghidup
matikan penerangan dimana personil yang sedang bertugas masih kurang
maksimal dalam pengisian MOT serta kurang efektifnya kerja personil
dikarenakan personil harus keliling terminal penumpang untuk menghidup dan
mematikan penerangan, apalagi saat ada permasalahan di tenant yang
mengharuskan personil segera datang. Peneliti memilih lokasi tersebut dengan
tujuan ingin mengetahui upaya yang dapat di ambil untuk mempermudah

personel dalam melaksanakan tugasnya secara maksimal.

2. Waktu Penelitian
Penelitian ini terhitung dari penelitian, pelaksanaan penelitian, sampai
pembuatan laporan penelitian. Penelitian dilaksanakan bulan Oktober 2023
hingga Juli 2024.
Tabel 111. 1 Wakiu Penelitian

No. Kegiatan MAR | APR | MEI | JUN | JUL

1. Penyusunan Proposal

2. Ujian Proposal

3. Pembuatan Alat & Pembuatan Laporan

4. Ujian Tugas Akhir




BAB1V
HASIL DAN PEMBAHASAN

A. Hasil Penelitian

Berdasarkan penelitian mengenai Profotype Sistem Otomatisasi Manajemen Operasional
Berbasis Traffic Dan Kontrol Penerangan Menggunakan [niernet of Things guna
mendukung kegiatan kontrol penerangan dan pengisian MOT yang dilakukan peneliti
dengan berdasar dari desain penelitian (Research and Development) R&D,
pengembangan Borg and Gall dimana pada pengembangan Borg and Gall terdapat

sepuluh tahapan yang dibuat agar produk yang dirancang mempunyai standar kelayakan.

B. Tahapan Potensi Masalah

Tahapan awal dalam pembuatan Profofype ini adalah melakukan analisis kebutuhan
dengan melakukan observasi awal disekitar Unit Listrik Bandar Udara Internasional
Juanda pada Bulan Oktober Tahun 2023. Pembuatan Profotype Sistem Otomatisasi
Manajemen Operasional Berbasis 7raffic Dan Kontrol Penerangan Menggunakan
Internet of Things ini adalah pada kegiatan rutin yang dilaksanakan di terminal 1 dan 2
Juanda, peneliti menemukan bahwa kegiatan pengontrolan dan pengisian ini masih
kurang efektif dan efisien dilakukan seperti teknisi lapangan harus mengontrol beberapa
penerangan langsung ke panel-panel yang ada diruang tunggu serta pelaporan dan
pengisian MOT yang masih secara manual

1. Sistem yang berjalan saat ini

Untuk saat ini, dalam kegiatan rutin yang dilaksanakan oleh unit listrik bandara pada
terminal 1 Juanda masih secara manual. Dalam hal ini pengontrolan masih dilakukan
secara manual di beberapa titik seperti penerangan pada gate 6 hingga 12, gate tersebut

di kontrol melalui Lighting panel general (Lpg) 23, 22, 24, 25, 26, dan 27.
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Gambar I'V. | Wiring instalasi lampu terminal 1 Juanda

Gambar IV. 2 Panel

2. System yang diinginkan
Hal yang menjadi acuan peneliti untuk mengembangkan suatu sistem inovasi baru yang

berfokus pada kegiatan kontrol dan monitoring MOT di Bandar Udara Internasional
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Juanda yaitu dengan membuat Profotfype Sistem Otomatisasi Manajemen Operasional
Berbasis Traffic dan Kontrol Penerangan Menggunakan [nternet of Things. Alat ini
dirancang agar memudahkan kegiatan rutin harian pengontrolan penerangan dan

monitoring MOT Di Bandar Udara Internasional Juanda.

C. Penelitian dan Pengumpulan Data
Metode penelitian dan teknik pengumpulan data yang digunakan dalam penelitian ini
menggunakan dua metode utama, yaitu wawancara dan observasi, yang dipilih karena
mampu memberikan pemahaman mendalam serta gambaran nyata terkait fenomena yang
diteliti. Wawancara dilakukan untuk menggali informasi dari narasumber yang memiliki
pengetahuan dan pengalaman relevan, sementara observasi digunakan untuk melihat
langsung situasi dan kondisi di lapangan. Kedua metode ini diharapkan dapat
memberikan data yang komprehensif dan valid mengenai kebutuhan dan kondisi
lapangan yang relevan.
1. wawancara
Wawancara adalah salah satu metode pengumpulan data yang efektif untuk mendapatkan
informasi langsung dari pihak yang terlibat dalam manajemen operasional dan
penggunaan sistem penerangan. Dalam penelitian ini, wawancara dilakukan dengan
beberapa pihak, antara lain:
a. Supervisor Operasional: Manajemen Operasional Berbasis Traffic digunakan untuk
mengoptimalkan penggunaan fasilitas sesuai dengan jumlah penerbangan. Selain itu,
pencatatan yang dilakukan oleh sistem, ini juga berguna untuk mengetahui dan
mengendalikan biaya perawatan fasilitas secara efektif.
b. Supervisor Listrik: Manajemen Operasional Berbasis Traffic adalah sistem digital
yang mencatat secara real-time penggunaan listrik di terminal penumpang, khususnya
pada lampu-lampu terminal. Sistem ini memungkinkan pemantauan konsumsi listrik
secara akurat, dengan mengonversi beban listrik yang terpakai menjadi nilai rupiah.
Waktu penggunaan lampu diatur berdasarkan jumlah penerbangan, sehingga efisiensi

energi dapat tercapai dengan optimal.

2. Observasi Partisipatif
Dalam penelitian ini, pengumpulan data dilakukan melalui metode Observasi Partisipatif,
di mana peneliti terlibat langsung dalam kegiatan operasional di terminal penumpang.

Berikut penjelasan rinci mengenai proses pengumpulan data:
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a. Keterlibatan Langsung dalam Operasional: Peneliti secara aktif berpartisipasi dalm
mengoperasikan lampu di terminal penumpang, termasuk mematikan dan
menghidupkan lampu pada beberapa panel yang tersedia. Waktu pengoperasian
lampu disesuaikan dengan jadwal yang ditentukan oleh Manajemen Operasional
Berbasis Traffic , yang telah disebarkan melalui grup WhatsApp.

b. Pengisian Data: Peneliti juga turut serta dalam pengisian data Manajemen
Operasional Berbasis 7raffic . Data ini dikirimkan dari grup WhatsApp ke Google
Spreadsheet yang telah disediakan oleh unit operasional bandara. Pengisian format
Google Spreadsheet dilakukan pada pagi hari sebelum penerbangan dimulai, sore
hari dan malam hari setelah semua penerbangan selesai.

c. Pelaporan Data: Data yang telah dikumpulkan dan dimasukkan ke dalam Google
Spreadsheet akan dikirimkan ke unit operasional bandara. Unit operasional bandara
kemudian melaporkan data tersebut kembali kepada manajer bandara.

d. Isi format Google Spreadsheet: format Google Spreadsheet yang disusun oleh unit
operasional bandara mencakup berbagai informasi penting seperti: lokasi
penerangan, perencanaan waktu hidup atau mati lampu, presentasi penggunaan

lampu, KWH penggunaan lampu dan biaya pengeluaran.

Melalui kombinasi wawancara dan observasi, data yang diperoleh menjadi lebih teliti dan
mendalam. Data ini kemudian dianalisis untuk mengidentifikasi kebutuhan spesifik dan
mengembangkan solusi yang tepat untuk sistem otomatisasi manajemen operasional
berbasis Traffic dan kontrol penerangan menggunakan loT. Hasil analisis data ini menjadi

dasar bagi pengembangan prototipe sistem yang akan diujikan pada tahap berikutnya.

D. Desain Produk

Tahap desain atau perencanaan, peneliti memulai proses merancang perangkat keras dan
perangkat lunak agar alat yang akan digunakan berjalan dengan sempurna.

1. Desain Perangkat Keras

Pada tahap ini peneliti mendesain perangkat keras untuk prototype sistem untuk
manajemen operasional berbasis Traffic dan kontrol penerangan menggunakan /nternet
of Things menggunakan sensor arus PZEMt dan NodeMCU ESP8266 yang akan
dikontrol melalui bylnk dan di monitoring dari Google Spreadsheet. Berikut wiring

keseluruhan perangkat keras dapat dilihat pada gambar 4.1
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Gambar I'V. 3 Wiring dan Desain Perangkat Keras
Sumber: penulis (2024)
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Adapun keterangan pada rangkaian dari gambar 4.1 diatas sebagai berikut:

Tabel 1V. 1 keterangan pada rangkaian

1. | Mikrokontroler ESP8266

Pin 3V Terhubung ke VCC pada modul sensor arus
dan relay

GND Terhubung ke GND pada modul relay dan
modul sensor arus

DI Terhubung ke IN1 pada modul relay

D2 Terhubung ke IN2 pada modul relay

D5 Terhubung ke TX modul sensor PZEM

D6 Terhubung ke RX modul sensor PZEM
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2. | Modul Relay 2 Channel

IN1 Terhubung ke D1 pada NodeMCU
IN2 Terhubung ke D2 pada NodeMCU
DC+ Terhubung ke 5Vpada NodeMCU
DC- Terhubung ke GND pada NodeMCU

COM (Relay 1)

Terhubung ke kabel fase (L) dari stopkontak

NO (Relay 1)

Terhubung ke lampu 1

COM(Relay 2)

Terhubung ke kabel fase (L) dari stopkontak

NO (Relay 2)

Terhubung ke lampu 2

3. Modul Sensor Arus

RX Terhubung ke D6 pada NodeMCU

X Terhubung ke D5 pada NodeMCU

5V Terhubung ke 5V pada NodeMCU

GND Terhubung ke GND pada NodeMCU

Kabel Terhubung ke kabel netral (N) dan fase (L)

input/output dari stopkontak

arus

4. | Lampu

Lampu 1 Terhubung ke NO (Relay 1) dan kabel netral
(N) dari stopkontak

Lampu 2 Terhubung ke NO (Relay 2) dan kabel netral
(N) dan stopkontak

Lampu 3&4 Terhubung sesuai kebutuhan jika ada relay

tambahan atau menggunakan relay yang

sama dengan konfigurasi paralel
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Selanjutnya, langkah berikutnya adalah merancang alur kerja sistem atau

Flowchart yang menyajikan representasi visual mengenai cara kerja Sistem

Otomatisasi Untuk Manajemen Operasional Berbasis 7raffic Dan Kontrol

Penerangan Menggunakan [nternet of Things. Flowchart ini

akan

menggambarkan setiap tahapan proses dari awal hingga akhir. Dengan adanya

Flowchart, diharapkan sistem ini dapat dengan mudah dan jelas dipahami.

Sistem dimulai dengan inisialisasi perangkat NodeMCU ESP8266, sensor

PZEM, koneksi WiFi, Blynk, dan Google Spreadsheet. Setelah inisialisasi,
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sistem membaca nilai arus dari PZEM-004T, mengkalibrasi dan mengonversi
nilai tersebut ke format yang sesuai. Selanjutnya, sistem menghitung daya
(Watt) berdasarkan nilai arus dan energi (kWh) berdasarkan daya dan waktu.
Data daya, dan energi kemudian dikirim ke Blynk untuk ditampilkan dan
dicatat ke Google Spreadsheet bersama dengan waktu pencatatan. Kontrol
lampu dilakukan melalui Blynk, di mana status lampu dibaca dan diaktifkan
atau dimatikan sesuai perintah dari Blynk. Setelah itu, sistem menunggu
interval waktu tertentu sebelum mengulangi proses dari pembacaan sensor

PZEM-004T. Proses ini terus berulang hingga sistem selesai.
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Gambar IV. 4 Flowchart Desain Perangkat Keras
sumber: penulis (2024)

E. Validasi Desain

Pada tahap validasi desain yang dilaksanakan di Bandara Juanda, dihadiri oleh Mas Putra
Febrianto selaku Supervisor Unit Airport Electrical, Bapak Bagus selaku Manajer Unit
Airport Equipment, Bu Agistinisa Aini selaku penguji dari perwakilan BPSDMP serta
Bapak Parjan selaku pembimbing dan penguji sidang On the Job Training. Dalam sesi ini,

rencana desain yang diajukan telah dinilai baik dan memenuhi standar yang diharapkan.




38

Namun, terdapat saran dari kedua pihak untuk memaksimalkan penggunaan
mikrokontroler dalam pengelompokan lampu. Saran tersebut mencakup penggunaan
mikrokontroler untuk mengendalikan jumlah kelompok lampu yang lebih banyak, serta
meningkatkan efektivitas dan efisiensi dalam pengontrolan dan pemantauan. Dengan
implementasi ini, diharapkan sistem pencahayaan bandara dapat diatur dan dipantau
dengan lebih optimal, mendukung operasional yang lebih efisien dan responsif terhadap

kebutuhan pencahayaan di berbagai area bandara.

F. Revisi Desain

Revisi desain telah dilakukan dengan penambahan komponen relay dan peningkatan
jumlah lampu untuk meningkatkan fungsionalitas sistem. Sebelumnya, sistem hanya
menggunakan satu relay untuk mengendalikan satu lampu. Namun, dalam revisi ini,
jumlah relay ditingkatkan menjadi dua, yang masing-masing mengendalikan dua lampu.
Dengan demikian, total lampu yang dapat dikendalikan telah meningkat menjadi empat
lampu. Perubahan ini bertujuan untuk memberikan fleksibilitas lebih besar dalam
mengatur pencahayaan di berbagai area, serta meningkatkan efisiensi penggunaan energi
dengan memanfaatkan kontrol yang lebih terpusat dan efektif. Diharapkan revisi ini akan
meningkatkan kinerja sistem secara keseluruhan, sesuai dengan kebutuhan operasional

yang lebih kompleks dan dinamis.
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Gambar 1V. 5 Flowchart Revisi Desain
sumber: penulis (2024)

G. Pengembangan Desain

Setelah rencana desain direvisi sesuai dengan yang diinginkan maka langkah selanjutnya
adalah pengembangan desain. Dimana pengembangan desain akan dimulai dengan
mempersiapkan komponen yang akan digunakan. Berikut komponen yang digunakan:

Tabel 1V. 2 keterangan komponen

Kelompok Komponen Keterangan
Mikrokontroller Arduino Lolin Nodemcu V3
Sensor Arus PZEM-004t
Relay relay module 3.3 v 2 channel
Perangkat Keras  Powersupply Adaptor
Fitting Lampu 4 Buah
Arduino Arduino Integrated Development
Environment (Ide)
Server Aplikasi Blynk

Perangkat Lunak
Server Google Spreadsheet
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Setelah tahap revisi desain selesai, proses berlanjut ke tahap pengembangan desain. Pada

tahap ini, persiapan komponen-komponen perangkat keras dan perangkat lunak menjadi

langkah utama yang perlu dilakukan. Komponen-komponen yang akan digunakan, seperti

ESP8266, PZEM-004T, relay, Blyvnk, dan Google Spreadsheet, harus dipersiapkan dengan

teliti untuk memastikan kinerja sistem yang optimal. Setelah semua komponen perangkat

keras dipersiapkan, langkah selanjutnya adalah merangkai perangkat tersebut sesuai

dengan desain yang telah dibuat. Proses perakitan ini harus dilakukan dengan hati-hati

dan sesuai dengan diagram rangkaian untuk memastikan semua komponen terhubung

dengan benar dan sistem dapat berfungsi sesuai dengan yang diharapkan.

Gambar 1V. 6 Pengembangan Desain

Berikut keterangan perakitan perangkat keras:

1.

Pin DS pada ESP8266 dihubungkan ke IN1 pada Relay 1. Ini untuk mengontrol relay
pertama dari ESP8266.

Pin D6 pada ESP8266 dihubungkan ke IN2 pada Relay 2. Ini untuk mengontrol relay
kedua dari ESP8266.

Pin GND pada ESP8266 dihubungkan ke GND pada relay PZEM-004T untuk
memberikan referensi ground.

Pin 5V pada ESP8266 dihubungkan ke DC+ pada relay untuk memberikan daya 5V
ke relay.

Pin 5V pada esp8266 dihubungkan ke 5V pada PZEM-004T untuk memberi daya
NO1 dan NO2 pada relay dihubungkan ke fase (L) dari Lampu 1 dan 2. Ketika relay
aktif, ini akan menutup sirkuit dan menyalakan lampu.

COMI dan COM2pada relay dihubungkan ke fase (L) dari power supply. Ini adalah

titik common untuk relay 1 dan relay 2.
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Berikut prinsip kerja pada alat ini:

1. Persiapan Awal:
a) Pastikan ESP8266, relay, dan PZEM terhubung sesuai diagram sirkuit.
b) Pastikan ESP8266 terkoneksi dengan jaringan WiFi yang tersedia.

2. Pengiriman Perintah dari Blynk:

a) Pengguna membuka aplikasi B/vnk dan menekan tombol "ON". Ketika tombol
"ON" ditekan, Blynk mengirimkan perintah digital

3. Penerimaan Perintah oleh ESP8266:

a) ESP8266 menerima sinyal perintah atau pesan teks dari Blynk. Perintah ini

diinterpretasikan oleh kode yang berjalan di ESP8266 untuk mengaktifkan relay.
4. Aktivasi Relay:

a) ESP8266 mengirimkan sinyal perintah ke input kontrol relay. Sinyal ini
membuat relay berubah status menjadi "close" atau tertutup, memungkinkan
arus listrik mengalir ke perangkat yang terhubung seperti lampu.

5. Pengaliran Arus Listrik:

a) Arus listrik yang mengalir ke perangkat melewati Current Transformer (CT)

yang terhubung ke PZEM. CT mendeteksi besaran arus yang mengalir.
6. Pembacaan Data oleh PZEM:

a) PZEM membaca parameter listrik seperti tegangan (V), arus (A), dan daya (W)
yang mengalir melalui CT. PZEM kemudian mengirimkan data ini ke ESP8266
melalui komunikasi serial.

7. Pengolahan Data oleh ESP8266:

a) ESP8266 menerima data dari PZEM dalam bentuk sinyal digital ESP8266
memproses dan memformat data tersebut sesuai dengan kebutuhan monitoring
daya listrik.

8. Pengiriman Data ke Google Sheets:

a) ESP8266 mengirimkan data yang telah diproses ke Google Sheets melalui API

Google Sheets. Hal ini memungkinkan pengguna untuk memonitor daya listrik

secara real-time di Google Sheels.

Setelah merangkai perangkat keras, tahapan selanjutnya adalah mengatur perangkat lunak
yang terdiri dari dua aplikasi: Blynk dan Google Spreadsheet. Langkah pertama adalah
mengonfigurasi aplikasi Blynk di smariphone. Mulailah dengan mengunduh dan

menginstal aplikasi Blynk, kemudian buat akun dan proyek baru. Setelah /ogin, langkah
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pertama adalah klik tanda "+" atau "New Project" di halaman utama aplikasi Blynk untuk
memulai proyek baru. Beri nama proyek baru “PENERANGAN”. Selanjutnya, pilih
perangkat, dalam hal ini ESP8266. Pilih jenis koneksi yang akan digunakan, seperti Wi-
Fi, untuk memastikan perangkat dapat terhubung dengan aplikasi. Setelah semua
pengaturan ini selesai, klik "Create Project" untuk membuat proyek baru Anda. Proyek
ini kemudian akan siap untuk diatur lebih lanjut, termasuk menambahkan widget dan
konfigurasi lainnya yang diperlukan untuk mengontrol perangkat keras yang telah

dirangkai.

Setelah proyek dibuat, token autentikasi akan dikirim ke email Anda. Salin token tersebut
karena akan digunakan nanti dalam kode ESP8266. Klik tombol "+" atau "Add Widget"
di layar proyek, kemudian pilih widget "Button" untuk menambahkan tombol ke
antarmuka proyek. Tambahkan tiga tombol dengan cara yang sama untuk "Hidup," dan
"Mati". Klik pada setiap tombol yang telah ditambahkan untuk mengatur konfigurasinya,
pilih pin yang sesuai yang akan dikontrol oleh tombol, dan beri label pada setiap tombol
sesuai fungsinya (Hidup, Mati). Atur mode tombol Push. Setelah semua pengaturan
selesai, klik ikon "Play" atau "Run" di bagian atas layar untuk memulai proyek. Pastikan
perangkat ESP8266 terhubung ke internet dan menggunakan token autentikasi yang telah

diberikan untuk memastikan semua fungsi bekerja dengan baik.
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Gambar V. 7 Blynk
sumber: penulis (2024)

Setelah mengatur perangkat keras dan aplikasi Blynk, langkah selanjutnya adalah
mengonfigurasi Google Spreadsheet untuk memonitoring sistem. Pertama, buka Google

Drive dengan masuk ke akun Google Anda. Buat spreadsheet baru dengan mengklik
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tombol "New" di sisi kiri atas dan memilih "Google Sheets." Di baris pertama spreadsheet,

tambahkan nama kolom-kolom berikut: Tanggal, Waktu, Watt (kWh), Gate 10, Gate 11.

PENERANGAN +# & &

File Edit Tampilan Sisipkan Format Data Alat Ekstensi Bantuan

Q. Menu 5 ¢ & I‘—f 100% - Rp % 0_ 00 123 Defaul.. - = |1
H13 -
A B c D E F
Datetime Watt (kWH) Cost GATE10 GATE 11
Tanggal Waktu
0,000
4 0,000
5 0.000
0,000
0,000
0,000
3 0,000
0 0,000
il 0,000
12 0,000
13 0,000
14 | 0,000
15 0,000
16 0,000

Gambar IV. 8 Google Spreadsheet
sumber: penulis(2024)

Selanjutnya, integrasikan Google Spreadsheet dengan ESP8266. Buka Google Apps

Script dengan memilih "Extensions" > "Apps Script." Buat script untuk menerima data

dari ESP8266 dan memasukkannya ke dalam spreadsheet, menggunakan fungsi seperti

"doGet(e)’ untuk menangani data yang diterima. Publikasikan script sebagai web app dan

salin URL yang dihasilkan. Kemudian, modifikasi kode pada ESP8266 untuk mengirim

data ke URL yang telah dibuat menggunakan HTTP request. Setelah data yang dikirim

sesuai dengan format yang diharapkan oleh script di Google Apps Script.
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¥ AppsSeript  tugas akhir

® Fila + P Jalankan ®)Debug doGet v  Logehksekusi
< # function doGet(e) {
ger . Log(JSON. stringify(e
O + ar result = 0K’
{§  Leyenan w if [le.parameter || Object.keys(e.parameter).length

result = “No Parameters

Date

fornatDate(Curr_Date, "Asis/Bangkok

tt = e.paranete

var status = e.parame ws;

Juates[watt).replace

jger . 1og( JSON . stringify( rowdata) ) :
var nesRange = sheet.getRange(newRon rowData.length);
newRange  setValues( [rondatal):

ice createTextutput {result

nction stripbuotes{value) {
rn value.replace

Gambar IV. 9 Apps script
sumber: penulis (2024)

Setelah mengatur Google Spreadsheet untuk memantau sistem lampu, langkah
selanjutnya adalah mengkonfigurasi Arduino IDE untuk memastikan ESP8266 dapat
berkomunikasi dengan spreadsheet melalui internet. Pertama, buka Arduino IDE di
komputer dan pastikan ESP8266 sudah terhubung dengan komputer melalui kabel USB.

Berikut langkah-langkah pengaturan pada Arduino IDE:

1. Buka Arduino IDE dan pergi ke menu "File" > "Preferences". Di sana, peneliti perlu
menyalin dan menempelkan URL berikut di kotak "Additional Board Manager
URLs":http://arduino.esp8266.com/stable/package esp8266com_index.json.
Setelah itu, klik "OK" untuk menyimpan pengaturan. Selanjutnya, pergi ke menu
"Tools" > "Board" > "Board Manager", dan cari "esp8266". Instal board manager
dari ESP8266 by ESP8266 Community untuk memungkinkan Arduino IDE
mengenali dan mendukung board ESP8266 dalam pengembangan proyek.
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2. Pergi ke menu "Tools" > "Board" dan pilih " NodeMCU 1.0 (ESP-12E Module)"
sebagai opsi board yang digunakan. Kemudian, pastikan untuk memilih port yang
sesuai dengan ESP8266 yang terhubung ke komputer Anda. Biasanya, Anda dapat
menemukan port yang digunakan oleh ESP8266 di menu "Tools" > "Port".

3. Unduh dan instal library tambahan yang diperlukan untuk proyek komunikasi dengan
Google Spreadsheet. Di Arduino IDE, navigasikan ke menu "Sketch" > "Include
Library" > "Manage Libraries". Di sini, cari dan instal library "WiFiManager,"
"Google Sheets AP1,"

4. Setelah library terinstal, lanjutkan dengan memodifikasi atau menulis kode Arduino
untuk ESP8266. Gunakan library yang telah diinstal untuk mengatur koneksi Wi-Fi

dan mengirim data ke Google Spreadsheet menggunakan HTTP request.

Gambar IV. 10 Coding Arduiono IDE
sumber: penulis (2024)

H. Pengujian Alat

Setelah melaksanakan pengembangan desain sistem kontrol lampu menggunakan
ESP8266 dan Arduino IDE, langkah selanjutnya adalah memasuki tahap pengujian dan
analisa. Pengujian dilakukan untuk memverifikasi bahwa sistem dapat beroperasi sesuai
dengan spesifikasi yang telah ditetapkan, seperti mengontrol lampu dengan tepat
menggunakan aplikasi Blynk, serta merekam data penggunaan lampu ke Google

Spreadsheet dengan akurasi yang diperlukan. Analisa kemudian dilakukan untuk
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mengevaluasi performa sistem, mengidentifikasi potensi perbaikan, dan memastikan
bahwa solusi yang diimplementasikan memenuhi kebutuhan dan standar yang telah
ditetapkan sebelumnya. Tahapan ini penting untuk memastikan kehandalan sistem
sebelum diterapkan secara lebih luas atau dalam lingkungan operasional yang
sesungguhnya. Berikut merupakan gambar dari hasil pembuatan dan pengembangan

perangkat keras, dapat dilihat pada gambar [V.11

Gambar I'V. 11 Hardware
sumber: penulis (2024)

Penelitian ini bertujuan untuk mengoptimalkan efisiensi waktu dan tenaga dalam
pengaturan lampu di terminal, serta untuk mengotomatiskan proses pencatatan yang
sebelumnya dilakukan secara manual. Dengan latar belakang ini, dirancanglah sebuah
alat yang mengintegrasikan teknologi untuk mengontrol lampu dari jarak jauh melalui
aplikasi Blynk. Selain itu, sistem ini juga memungkinkan monitoring dan pencatatan data
Manajemen Operasional Berbasis 7raffic  secara real-time menggunakan Google
Spreadsheet. Pendekatan ini diharapkan dapat meningkatkan efisiensi operasional dan
mengurangi beban kerja manual dalam pengelolaan terminal, sekaligus memastikan

bahwa semua proses berjalan efektif sesuai dengan kebutuhan yang ada.

1. Pengujian Kontrol Melalui Aplikasi Bylnk

Pengujian kontrol melalui aplikasi Blynk dilakukan untuk mengevaluasi keberhasilan
fungsi sistem kontrol yang telah dikembangkan. Pengujian ini melibatkan pengendalian
lampu pada Gate 10 dan Gate 11 menggunakan aplikasi Blynk. Hasil pengujian ini dapat
dilihat pada gambar berikut, yang menunjukkan efektivitas dan kehandalan sistem dalam

mengontrol lampu secara remote melalui aplikasi Blynk.




Gambar V. 12 Kontrol Blynk
sumber: penulis (2024)
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Dapat dilihat pada Gambar IV.12 di atas bahwa saat tombol "ON" pada lampu Gate 10

ditekan, indikator daya menampilkan nilai sesuai dengan beban yang dinyalakan. Hal

yang sama terjadi ketika tombol pada Gate 11 ditekan, di mana indikator daya juga

menunjukkan nilai yang sesuai dengan beban yang diaktifkan.

2. Pengujian Monitoring Melalui Google Spreadsheet

Pengujian Monitoring Melalui Google Spreadsheet penting untuk memastikan efektivitas

dan keandalan sistem kontrol lampu yang terintegrasi dengan aplikasi Blynk. Dengan

merekam data operasional secara real-time, Hasil pengujian ini dapat dilihat pada gambar

IV.13
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a PENERANGAN +# & &
File Edit Tampilan Sisipkan Format Data Alat Ekstensi Bantuan

Q, Menu 6 o 3 ﬁ' 100% = Rp % 0_ 00 123 Defaul... - - |10
08 -
A B c D E F
Datetime
Tanggal Waktu Watt (kWH) Cost GATE10 GATE 11
3 2110772024 9:25:30 0,002 3.000 ON
4 211072024 9:25:38 0,002 3.000 ON
5 21/07/2024 9:25:47 0,002 3.000 OFF
& 2110772024 9:25:53 0,002 3.000 ON
T 211072024 9:27:47 0,002 3.000 OFF
8 2110772024 931:10 0,002 3.000 ON
9 2110772024 9:34:47 0,002 3.000 OFF
10 21/07/2024 9:34:50 0,002 3.000 OFF
11 0.000
12 0.000
13 0.000
14 0.000
15 0.000

Gambar IV. 13 Monitoring Google Sheet
sumber: penulis (2024)

Hasil pengujian pada Google Spreadsheet, seperti yang terlihat pada Gambar IV.11,
menunjukkan bahwa saat tombol lampu Gate 10 dan Gate 11 ditekan melalui aplikasi
Blynk, kolom-kolom yang relevan di spreadsheet secara otomatis terisi dengan data yang
sesuai. Data yang tercatat mencakup informasi tentang Tanggal, Waktu, Watt (kWh), Gate
10, Gate 11.

Datetime
Watt (kWH) Cost GATE10 GATE 11
Tanggal Waktu
21/07/2024 9:25:30 0,002 3,000 ON
21/07/2024 9:25:38 0,002 3,000 ON
21/07/2024 9:25:47 0,002 3,000 OFF
21/07/2024 9:25:53 0,002 3,000 ON
21/07/2024 9:27-47 0,002 3,000 OFF
21/07/2024 9:31:10 0,002 3,000 ON
21/07/2024 9:34:47 0,002 3,000 OFF
21/07/2024 9:34:50 0,002 3,000 OFF
0,000

Gambar 1V. 14 Hasil Pengujian
sumber: penulis (2024)

1. Hasil pengujian

Pengujian terhadap prototipe sistem otomatisasi manajemen operasional berbasis fraffic
dan kontrol penerangan menggunakan fnternet of Things (10T) menunjukkan hasil yang
memuaskan. Dalam pengujian kontrol melalui aplikasi Blynk, lampu pada Gate 10 dan
Gate 11 berhasil diaktifkan dan dimatikan secara remote dengan akurasi tinggi. Indikator

daya yang terintegrasi menunjukkan pembacaan yang sesuai dengan konsumsi energi
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aktual ketika lampu dinyalakan, membuktikan bahwa sistem ini dapat menjalankan
fungsinya dengan baik. Selain itu, data konsumsi energi yang dikirimkan secara otomatis
ke Google Spreadsheet juga tercatat dengan akurasi yang tinggi, mencakup informasi
penting seperti tanggal, waktu, dan konsumsi daya (kWh) untuk setiap gate. Hal ini
membuktikan bahwa sistem ini mampu melakukan pencatatan data operasional secara

real-time, yang sebelumnya dilakukan secara manual.

Pengujian lebih lanjut dilakukan untuk memastikan stabilitas dan efisiensi sistem dalam
jangka waktu yang lebih panjang. Hasilnya, sistem menunjukkan konsistensi dalam
kontrol penerangan dan pencatatan data selama periode uji coba tanpa mengalami
gangguan yang berarti. Penggunaan sensor PZEM-004T untuk pengukuran arus dan
mikrokontroler ESP8266 yang terintegrasi dengan aplikasi Blynk terbukti efektif dalam
mendukung fungsi otomatisasi yang diinginkan. Secara keseluruhan, prototipe ini tidak
hanya berhasil memenuhi ekspektasi awal tetapi juga menunjukkan potensi untuk
meningkatkan efisiensi energi dan mengurangi beban kerja manual di lingkungan

bandara.

Selanjutnya, apabila prototipe ini diadaptasikan di Bandar Udara Juanda, perlu dilakukan

penyempurnaan dan adaptasi sebagai berikut:

Tabel IV. 3 komponen penyempurnaan

Komponen Prototype Real
Relay 2 channel 3.3v Electromechanical Relay
Esp8266 Esp8266 Esp8266
Pzemp-004t Pzem-004t Pzem-004t

Perbaikan tersebut meliputi penggunaan relay yang lebih sesuai dengan kebutuhan
operasional di lingkungan nyata, yaitu dengan mengganti relay 2 channel 3.3v dengan

Electromechanical Relay yang lebih tahan lama dan handal dalam operasional skala besar.

Berikut keterangan perkiraan perhitungan yang dibutuhkan :

1. Relay

Dalam prototipe, relay yang digunakan adalah relay satu saluran 3.3V, yang tidak cukup
untuk aplikasi skala besar. Untuk penerapan di lokasi seperti Bandara Juanda, sangat
penting untuk meningkatkan solusi yang lebih kuat. Spesifikasi yang direkomendasikan
mencakup Relay Elektromekanis atau Solid State Relay (SSR) dengan kapasitas

minimum 20 Ampere masing-masing. Di bawah ini adalah rincian perhitungan yang




50

diperlukan untuk menentukan konfigurasi relay yang sesuai. Untuk memastikan sistem

dapat menangani kebutuhan daya dengan efisien, pertimbangkan perhitungan berikut:

Total Daya = 1.741 x 10 watt = 17.410 watt = 17,41 kW

Total Daya 17410
Arus Total = = =79,14 4
Tegangan 220

kapasitas Relay = 79,14 x 1,25 = 98,934

79,14
jumlah relay yang Dibutuhkan = 0 - 3,96

dengan demikian, total 4 relay, masing-masing dengan kapasitas 20 A, diperlukan untuk

memenuhi kebutuhan sistem.

2. Esp8266

Dalam sistem prototipe, ESP8266 digunakan sebagai pengontrol utama untuk
mengoperasikan lampu melalui aplikasi Blynk. Dengan prototipe yang hanya
menggunakan satu modul ESP8266 yang memiliki 11 pin GPIO, kemampuan ini
memungkinkan kontrol terbatas pada jumlah perangkat. Namun, dengan jumlah lampu
yang perlu dikontrol sebanyak 1.741 buah, dibutuhkan lebih banyak unit ESP8266 untuk
memastikan setiap lampu dapat dikendalikan dengan efektif. Untuk menentukan jumlah

unit ESP8266 yang diperlukan, kita dapat melakukan perhitungan sebagai berikut:

1741
Jumlah ESP8266 = ETE 158,27

Dengan demikian, untuk mengendalikan 1.741 lampu, dibutuhkan 16 unit ESP8266.
Setiap unit ESP8266 akan mengontrol sekitar 11 lampu, memberikan kemampuan

pengontrolan yang efisien dan terorganisir untuk keseluruhan sistem.

3. Pzem-004T

Dalam sistem pengontrolan pencahayaan, Pzem-004T digunakan untuk mengukur
berbagai parameter listrik seperti tegangan AC, arus, daya aktif, dan energi. Untuk
mengelola dan memantau 1.741 lampu dengan efektif, diperlukan sekitar 18 unit Pzem-

004T. Berikut adalah perhitungan rinci mengenai kebutuhan ini:
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1000 watt
arus per grup = —oo - = 4,55 A
1000
jumlah lampu per grup = ET 100
umlah —1741—1741
jumian grup = W = ’

Dengan demikian, dibutuhkan 18 unit Pzem-004T untuk memantau setiap grup lampu
secara efektif. Setiap Pzem-004T akan bertanggung jawab untuk mengukur parameter
listrik dari masing-masing grup, memberikan data yang akurat dan real-time untuk

pengelolaan energi dan pemantauan sistem.




BABY

KESIMPULAN DAN SARAN
A. KESIMPULAN
Berdasarkan penelitian yang dilakukan dalam tugas akhir ini, kesimpulan yang dapat
diambil adalah Prototipe sistem otomatisasi manajemen operasional berbasis fraffic dan
kontrol penerangan menggunakan [nternet of Things (IoT) telah berhasil dibuat dan
dapat digunakan sesuai dengan desain. Perangkat keras dirangkai dengan baik,
sementara perangkat lunak dapat diintegrasikan untuk mendukung fungsi sistem.
Pengujian menunjukkan bahwa prototipe ini dapat dijalankan dengan lancar,
memungkinkan kontrol lampu secara remote pada Gate 10 dan Gate 11 melalui aplikasi
Blynk. Selain itu, prototipe ini berhasil mencatat seperti tanggal, waktu, daya (watt),
status on/off setiap gatenya di google sheet.
B. SARAN
Berdasarkan penelitian dan implementasi sistem otomatisasi dan kontrol penerangan
berbasis IoT, terdapat beberapa saran untuk meningkatkan kinerja dan keandalan sistem
otomatisasi manajemen operasional berbasis traffic dan kontrol penerangan berbasis
IoT, beberapa langkah perbaikan diperlukan. Pertama, mengganti relay 2 channel 3.3V
dengan Electromechanical Relay atau Solid State Relay (SSR) berkapasitas minimal 20
Ampere untuk mendukung operasional skala besar. Penambahan unit ESP8266 dan
PZEM-004T juga diperlukan untuk mengontrol dan memantau 1.741 lampu secara
efektif, dengan 16 unit ESP8266 mengendalikan sekitar 11 grup lampu dan 18 unit
PZEM-004T memantau setiap grup. Penggunaan mikrokontroler yang lebih banyak
memungkinkan pengelompokan lampu yang lebih baik, sehingga pengaturan
pencahayaan lebih fleksibel dan efisien. Selain itu, pengembangan algoritma canggih
untuk pengaturan pencahayaan berdasarkan data real-time tentang traffic dapat
meningkatkan efisiensi energi. Integrasi dengan sistem manajemen bandara lainnya
akan memberikan analisis dan kontrol lebih komprehensif. Implementasi sistem ini di
Bandar Udara Juanda memerlukan adaptasi skala besar, termasuk persiapan
infrastruktur, pelatihan teknisi, dan penyusunan prosedur operasi standar. Monitoring
dan evaluasi berkala penting untuk memastikan sistem berjalan optimal dan penelitian

lanjutan akan terus dilakukan untuk meningkatkan kemampuan dan efisiensi sistem.
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Lampiran 3 Arduino IDE

#define BLYNK PRINT Serial

#define BLYNK_TEMPLATE ID "TMPL6beP1dtFY"

#define BLYNK_TEMPLATE NAME "PENERANGAN"

#define BLYNK AUTH_TOKEN "1d7c6W3GdaZepQY1Or 6B2tQoXcOLMXG"

#include <ESPR266WiFi.h>
#include <WiFiClientSecure.h>
#include <BlynkSimpleEsp8266.h>
#include <PZEM004Tv30.h=

#define PZEM_RX_PIN D5
#define PZEM_TX PIN D6

PZEMO004Tv30 pzem(PZEM_RX_PIN, PZEM_TX_PIN);

#define ON_Board LED 2
#define RELAY1_PIN D1
#define RELAY2 PIN D2

const char* ssid = "PPP"; // GANTI NAMA WIFI
const char* password = "Password123@(@"; // GANTI PASWORD WIFI

const char* host = "script.google.com™;
const int httpsPort = 443;

WiFiClientSecure client;

/I Google spreadsheet script ID
String GAS D = "AKfycbzVLAzmaHCTd iFYRqOuEXW-
JHEcOiFRwaA_twLONoBNGIUD({t9xIzVDI1 LUxxrtEOR";

// Define variables

double currentValue;

bool relayl State = false;

bool relay2State = false;

float voltage, current, power, energy, frequency, pf;

void setup() {
Serial.begin(115200);

WiFi.begin(ssid, password);
Serial. println("");

pinMode(ON_Board LED, OUTPUT);
digital Write(ON_Board LED, HIGH);

Serial.print("Connecting");

while (WiFistatus() != WL_CONNECTED) {
Serial.print(".");
digital Write(ON_Board LED, LOW);
delay(200);
digitalWrite(ON_Board LED, HIGH);
delay(200);




¥

digitalWrite(ON Board LED, HIGH);
Serial. println("");

Serial. print("Successfully connected to : ");
Serial. println(ssid);

Serial.print("IP address: ");

Serial. println(WiFi.locallP());
Serial.println();

client.setInsecure();
Blynk.begin(BLYNK_AUTH_TOKEN, ssid, password);

pinMode(RELAY1 PIN, OUTPUT);
pinMode(RELAY2 PIN, OUTPUT);

digitalWrite(RELAY1_PIN, LOW);
digitalWrite(RELAY2 PIN, LOW);
}

void loop() {
Blynk.run();
readCurrentSensor();

B

// Subroutine for sending data to Google Sheets

void sendData(String relay, float currentData, String lamp) {
Serial. printin("= =");
Serial. print("connecting to ");
Serial. printin(host);

if (!client.connect(host, httpsPort)) {
Serial.printIn("connection failed");
return;

i

String string_current = String(currentData, 3);

String url = "/macros/s/™ + GAS_ID + "/exec?relay=" + relay + "&watt="+ string_current +
"&status=" + lamp :

Serial.print("requesting URL: ");

Serial.printin(url);

client.print(String("GET ") + url + " HTTP/1.1\r'n" +
"Host: " + host + "\r'n" +
"User-Agent: BuildFailureDetectorESP8266\r'n" +
"Connection: close\rin\rin");

Serial.println("request sent");

while (client.connected()) {
String line = client.readStringUntil("n");
if (line == "\t") {
Serial.println("headers received");
break:
H
¥

String line = client.readStringUntil("n");




Serial.println(line);
if (line.startsWith( " {\"state\":\"success\"")) {
Serial.println("esp8266/Arduino CI successfull!");
} else {
Serial.println("esp8266/Arduino CI has failed");
}
Serial.print("reply was : ");
Serial.println(line);
Serial.println("closing connection™);
Serial. println("== =");
Serial.println();

}..

BLYNK WRITE(V1) {
relay 1 State = param.asInt();
currentValue = readCurrentSensor();
sendData("GATE10", currentValue, relayState ? "ON" : "OFF");
/I Blynk.virtual Write(V0, String(currentValue, 3));
digital Write(RELAY 1_PIN, relaylState ? HIGH : LOW);
H

BLYNK WRITE(V2) {
relay2State = param.asInt();
currentValue = readCurrentSensor();
sendData("GATE11", currentValue, relay2State ? "ON" : "OFF");
/I Blynk.virtual Write(V0, String(currentValue, 3));
digital Write(RELAY2_PIN, relay2State ? HIGH : LOW);
H

float readCurrentSensor() §

/I Read the data from the sensor
voltage = pzem.voltage();
current = pzem.current();
power = pzem.power();

energy = pzem.energy();
frequency = pzem.frequency();
pf =pzem.pf();

float dayaDigunakan;

/! Check if the data is valid

if (isnan(voltage)) {
voltage = 0;

¥

else if (isnan(current)) {
current =0

H

else if (isnan(power)) {
power = 0;

}

else if (isnan(energy)) {
energy = 0;

}

else if (isnan(frequency)) {
frequency = 0;

I




else if (isnan(pf)) {
pf=0;
H
else |
{/ Print the values to the Serial console
// Serial.print("Voltage: ");  Serial.print(voltage);  Serial.printin("V");
// Serial.print("Current: ");  Serial.print(current);  Serial.printin("A");
/f Serial.print("Power: "); Serial.print(power); Serial.println("W");
/I Serial.print("Energy: ");  Serial.print(energy,3);  Serial.printIn("kWh");
/f Serial.print("Frequency: "); Serial.print(frequency, 1); Serial.println("Hz");
/I Serial.print("PF: "); Serial.printin(pf);
Blynk.virtualWrite(V0, energy);
dayaDigunakan = energy;
Serial.print(energy);
Serial.print(", ");
Serial.println(dayaDigunakan);
delay(500);
'

return dayaDigunakan;
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